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Unit-1: Introduction to Computer System [LH 5 Hrs] 
1.1-Introduction to Computers 
The word Computer comes from 'compute', which means to 'calculate'. The word 'calculate' 

means to find out the result of some operation on a number of values (numeric). In 

computation, however, the meaning is not limited to the result of some operation on numeric 

values; here, the operations on the non-numeric values are also incorporated. One essential 

difference is that computation involves comparison of values, be it numeric or non-numeric, 

besides the usual arithmetic operations. In fact, computation involves any kind of operation 

with any kind of values. 

A computer can be defined as a multipurpose, programmable, electronic data processing 

device that is capable of accepting input; processing it and producing a refined data as output. 

 

Input  Processing  Output  

 

Man is today capable of processing information much faster than he was before. Because of 

this, man has achieved unimaginable achievements in areas such as space technology, 

communications, etc.  

The two principal characteristics of a computer are: 

 It responds to a specific set of instructions in a well-defined manner. 

 It can execute a prerecorded list of instructions (a program) 

 

1.1.1-Characteristics of computers 
 High processing speed: Computers are capable of carrying out the task with enormous 

speed.  

 High accuracy: The accuracy of a Computer is consistently high. The accuracy of the 

computer is best achieved by programming them in the most efficient manner. When it 

comes to very complex mathematical or scientific problem the computer‟s accuracy has 

no substitute. 

 High storage capacity: Computers can store enormous quantity of information. Large 

volumes of storage occupy much lesser space compared to paper documents and this 

aspect of computers makes them more powerful.  

 Versatility: Computers are versatile in that they can perform almost any task, provided 

they are given the appropriate logical steps.  

 Automation: Computer performs operations automatically. Once a programming logic is 

initiated the computer performs repeated operations without human interventions until 

program completion.  

 Diligence: Computers are machines and that do not get tired or „lose concentration‟ like 

human beings. If a large number of calculations say million calculations are to be 

performed the resultant output will remain exactly the same even if operations are 

repeated any number of times. 

 

Though the computer has become the most powerful tool, it is still a 'Garbage In Garbage 

Out' machine. It is totally dependent on us for the way it operates. It is not capable of doing 

anything if we do not tell it (instruct) how to do it. 

 

1.1.2-Importance of Computers in Business 
Computer plays an important role in business environment as every organization adopts it in 

some form or the other to perform the tasks in effective manner. In the past few years‟ rapid 

development in IT, particularly in communications, electronic service networks, and 

multimedia have opened up new opportunities for corporate. All these are contributing 

towards new and effective ways of processing business transactions, integrating business 

processes, transferring payments and delivering services electronically. It has affected the 

business in the following ways: 
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1. Office Automation 

Computers have helped automation of many industrial and business systems. They are used 

extensively in manufacturing and processing industries, power distribution systems, airline 

reservation systems, transportation systems, banking systems, and so on. Computer aided 

design (CAP) and computer-aided manufacture (CAM) are becoming popular among the 

large industrial establishment. 

 

2. Stores large amount of date and information 

Business and commercial organizations need to store and maintain voluminous records and 

use them for various purposes such as inventory control, sales analysis, payroll accounting, 

resources scheduling and generation of management reports. Computers can store and 

maintain files and can sort, merge or update as and when necessary. 

 

3. Improves Productivity 

With the introduction of word processing software, Computers have recently been applied to 

the automation of office tasks and procedures. This is aimed at improving the productivity of 

both clerical & managerial staff. 

 

4. Sharing of data and information 

Due to networking of computers, where a number of computers are connected together to 

share the data and information, use of e-mail and internet has changed the ways of business 

operations. 

 

5. Competitiveness 

Computers offer a reliable and cost-effective means of doing business electronically. 

Routine tasks can be automated. The customers can be provided support round the clock, 

which is 24 hours a day. With advancement in IT sector, corporate are spreading business 

around the world thus, increasing their presence and entering new markets. 

 

6. Security 

To provide security to data and important computer programs, almost every organization has 

some security programs to avoid the illegal access of the company‟s information by 

unauthorized persons. The three fundamental attributor of a security program are 

confidentially, integrity and availability which allow access to only authorized persons in an 

organization. 

 

7. Cost Benefits 

The extensive availability of internet based information means that companies have a wider 

choice of suppliers which leads to a more competitive pricing. Due to the presence of internet 

the role of the middleman becomes less important as companies can sell their product or 

services directly to the customer. 

 

8. Marketing 

Corporate engaged in e-business can take help of their respective websites to create brand 

awareness of their products, thus, creating new avenues of promotion of their products. In 

addition, companies‟ websites can also provide better services such as after sales service to 

the customer. 

 

1.2-Data Processing 
Data are a vital organizational resource that needs to be managed like other important 

business assets. Today‟s business enterprises cannot survive or succeed without quality data 

about their internal operations and external environment. 
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1.2.1-Data versus Information 

Data 

 Data refers to raw facts, unevaluated facts, figures, symbols, objects, events, etc from 

which information is generated. 

 Data appear in the form of text, numbers, figures, or any combinations of these 

 

Information 

 Data is processed and converted into a form that is useful to the decision-maker. 

 Information is facts, principles, knowledge, experience, and intuition that have been 

put into a meaningful and useful context and communicated to a recipient who uses it 

to make decisions. 

 

 

 

 

 

 

The function of an information system is to change "data" into "information", using the 

following processes: 

 Collection- collecting data through surveys, interviews, sensors, documents, 

newspapers, or any other appropriate means. 

 Conversion - transforming data from one format to another, from one unit of 

measurement to another, and/or from one feature classification to another 

 Storing- data is classified and sorted to arrange it in a meaningful form. 

 Organization - organizing or re-organizing data according to database management 

rules and procedures so that they can be accessed cost-effectively 

 Structuring - formatting or re-formatting data so that they can be acceptable to a 

particular software application or information system 

 Modeling - including statistical analysis and visualization of data that will improve 

user's knowledge base and intelligence in decision making 

 Summarizing- When processed data becomes information, it can be condensed and 

summarized to make it more useful to the decision-maker.  

 Retrieval and Dissemination-The information is then retrieved, and circulated to 

concerned stakeholders for current or further use. 

 

Note: - It is important to note that simply executing all of the steps discussed above does not 

guarantee that data will become information. If the processing is inaccurate or inappropriate, 

its output maybe useless to the decision-maker. 

 

Many people use the terms "data" and "information" as synonyms but these two terms 

actually convey very distinct concepts. "data" is defined as a body of facts or figures, which 

have been gathered systematically for one or more specific purposes. "information" is 

defined as data which have been processed into a form that is meaningful to a recipient and is 

of perceived value in current or prospective decision making. 

 

1.2.2-Characteristics of Information 
Although data are ingredients of information, not all data make useful information 

 data not properly collected and organized are a burden rather than an asset to an 

information user 

 data that make useful information for one person may not be useful to another person 

 

The characteristics of good information are subjectivity, relevance, timeliness, consistency, 

completeness, accessibility, reliability, and usability. 

 

INPUT PROCESS OUTPUT 

FEEDBACK 



4 

Subjectivity:  The value and usefulness of information are highly subjective, because what is 

information for one person may not be for another. For example even small changes in the 

price of a stock can be meaningful to a stockbroker, because these changes may influence 

buying and selling decisions. However, to a layperson, a stock price may be just a number, 

with little or no meaning. 

 

Relevance: Information is good only if it is relevant- that is, pertinent and meaningful to the 

decision-maker. For example, suppose a plant manager is trying to determine why a certain 

machine breaks down frequently. For that plan manager, the number of units that the machine 

has produced in the last 5 years is probably not relevant to the problem at hand. 

 

Timeliness: Timeliness refers to the currency of the information presented to the users. 

Information must be delivered at the right time and the right place to the right person. 

Currency of data or information is the time gap between the occurrences of an event in the 

field until its presentation to the user (decision maker). When this amount of time is very 

short, we describe the information system as a real-time system. Many organizations produce 

large volumes of reports without regards to when the information is needed; this greatly 

diminishes the value of their reports. 

 

Accuracy/consistency:  Accuracy is measured by comparing the data to actual events. 

Information must be free of errors, because erroneous information can result in poor 

decisions and erode the confidence of users. Note, however that accuracy is a relative 

concept; its meaning varies from context to context. For example, great precision is not 

required in predicting the number of customers at a restaurant, but is critical for a space 

mission. 

 

Correct information format: Information must be in the right format to be useful to the 

decision-maker. For example, if a manager wants to know the total a sale of product x last 

year, the most appropriate format is an annual summary of sales figure for the product. The 

format should be such that it can be applied directly to the problem at hand without further 

processing. 

 

Completeness: Information is said to be complete if the decision-maker can satisfactorily 

solve the problem at hand using that information. Although completeness of information is 

highly describe, often-complete information is not available. Managers are compelled to 

make decisions even when their information is incomplete: this is practically true for 

problems that require intuition and judgment. However, if most, though not all, of the 

essential information necessary to make a decision is available, the decision-maker may view 

the information as essentially complete. 

 

Accessibility: Information is useless if it is not readily accessible to decision makers, in the 

desired format, when it is needed. Advances technology has made information more 

accessible today than ever before; however there is also a downside to this development. 

Sometimes managers feel overwhelmed by the large volumes of information that are readily 

available to them. Also, if information is easily accessible, it may fall into the wrong hands: 

this can seriously jeopardize the company. Hence there should be a balance between 

accessibility and security; we discuss some methods for achieving information security in an 

organization.  

 

 

 

1.3-Classification of Computers  
A computer system exists in a wide range of sizes and power. It may be classified into 

different types according to the principle of operation or on the basis of their work, size, and 

brand. The classification of computing system varies with the advancement of technology. 
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1.3.1-Analog Computers 
An analog computer is a form of computer that uses the continuously changeable aspects of 

physical phenomena such as electrical, mechanical, or hydraulic quantities to model the 

problem being solved. Computations in analog computers are carried out with physical 

quantities such as voltage, current, temperature, and etc. The devices that measure such 

quantities are analog devices example voltmeter (measures voltage), ammeter (measures 

current), thermometer (measures temperature), and speedometer (measures speed). Analog 

computers operate by measuring rather than counting.  

The main advantage of analog computer is that all calculations take place in parallel 

and hence these are faster. But their accuracy is poor as compared to digital computers. 

Analog computers are mostly used in engineering and scientific application.  

 

Features of Analog Computer 

 Operates by measuring voltages and currents. 

 The accuracy of this computer is poor. 

 It has limited memory space. 

 It is not versatile. 

 

1.3.2-Digital Computers 
A digital computer is an electronic computing machine that uses the binary digits (bits) 0 and 

1 to represent all forms of information internally in digital form.  

The digital computers are devices capable of solving problems by processing information in 

discrete (discontinuous) form and all operations are carried out at extremely fast rate. Digital 

computer stores data in terms of digits (numbers) and proceeds in discrete steps from one 

state to the next.  In digital computers, even letters, words and whole texts are represented 

digitally. 

 

Features of digital computer 

 They work by counting numbers. 

 The accuracy of this machine is very high. 

 They have large memory capacity. 

 They are versatile in nature. 

 Digital computers are much faster than analog computers and far more accurate. 

 They are multipurpose machines which many solve several categories of problems.  

 They are generally used for business and scientific application.  

 

1.3.3-Hybrid Computers 
Hybrid computers as the name suggests are a hybrid of analog and digital computers. Hybrid 

computer is developed in such a way that it can perform the task of digital as well as analog 

computer. These computers utilize the best qualities of both the digital and analog computers. 

It helps the user to process both continuous and discrete data. In the hybrid computers a 

converter is fixed to convert the analog data into digital data and vice versa. 

CLASSIFICATION OF COMPUTERS 

On the basis of work On the basis of size On the basis of brand 

a. Analog computer 

b. Digital computer 

c. Hybrid computer 

a. Super computer 

b. Mainframe computer 

c. Mini computer 

d. Microcomputer 

a. IBM PC 

b. IBM Compatible 

c. Apple/Macintosh 
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Hybrid computers are best used in hospitals where analog part is responsible for 

measurement of patient‟s heart beat, blood pressure, etc. and then the operation is carried out 

in digital fashion to monitor patient‟s vital science. Hybrid computers are also used in 

weather forecasting and airplanes. 

 

1.3.4-Microcomputers 
A microcomputer is a small, relatively inexpensive single-user computer with a 

microprocessor as its central processing unit (CPU). It includes a microprocessor, memory, 

and input/output (I/O) facilities. It requires a smaller space and can be placed on the table. It 

uses a keyboard as a general input device and monitor as output device. Microcomputers 

became popular in the 1970s and 80s with the advent of increasingly powerful 

microprocessors. The predecessors to these computers, mainframes and minicomputers, were 

comparatively much larger and more expensive. Microcomputers are also called personal 

computers (PC). Typically, only one user could use the system. IBM PCs are the example for 

microcomputer.  

 

Advantages of micro computer 

a) They are small and portable. 

b) They are relatively inexpensive. 

c) They work as soon as they are switched on. 

d) They have excellent graphic capabilities, 

e) They do not occupy much space. 

f) They do not consume much power. 

 

1.3.5-Minicomputers 
A minicomputer (colloquially, mini) is a class of multi-user computers that lies in the 

middle range of the computing spectrum, in between the largest multi-user systems 

(mainframe computers) and the smallest single-user systems (microcomputers or personal 

computers). These computers are more powerful and more expensive than microcomputer. 

These are mainly multi-user systems where many users simultaneously work on the system. 

Minicomputers possess greater storage capacity and larger memory as compared to 

microcomputers. These are even capable of handling more input-output devices.  

Mini computers were also known as midrange computers. They had relatively high 

processing power and capacity that mostly fit the needs of mid-range organizations. They 

were mainly used in universities, industrial establishments, telecommunication, police 

headquarters, banks etc. 

 

1.3.6-Mainframe Computers 
Mainframe computers are computers used primarily by corporate and governmental 

organizations for critical applications, bulk data processing such as census, industry and 

consumer statistics, enterprise resource planning, and transaction processing. 

These computers are designed to handle huge volumes of data and information. These can 

support more than 100 users at same time. These are very large and expensive. Mainframe 

computers have great processing speed and very large storage capacity, memory as compared 

to minicomputers. These computers even possess and work with more than one processor at 

the same time. Thus one can say these are multi-users, multiprocessors systems. Very 

sophisticated operating is needed to control and supervise their operation.  

These are costly and they have big capacity of processing task and mainly used by big 

industries, engineering, universities, banks, and for scientific calculations.  

 

1.3.7-Supercomputers 
Super computers are extremely fast computer that can perform hundreds of millions of 

instructions per seconds. They are most expensive and the most powerful computers made to 

process complex and time-consuming calculations and are employed for specialized 

applications that require immense amounts of mathematical calculations. They are designed 
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to process complex scientific jobs. These consist of several processors running together 

thereby making them immensely faster and powerful. These computers are capable of 

handling huge amounts of calculations that are beyond human capabilities. Supercomputers 

can perform billions of instructions per second. Some of the today‟s supercomputers have the 

computing capability equal to that of 40000 microprocessors. These are normally 64-bits 

machines. They execute about 100 million instructions per seconds (MIPS).  

The applications are weather forecasting, nuclear science research, aerodynamic 

modeling, and seismology, analysis of geological data, graphics and metrology.  

 

1.3.8-IBM PC 
IBM PC stands for International Business Machine Personal Computer. The IBM is the one 

of the largest computers and other electronic equipment manufacturing company in the 

world. It was established in USA in 1924. IBM PC is a micro-computer produced by IBM 

Company. The computers produced by this company are reliable, durable and have high 

capability. 

 

1.3.9-IBM Compatible 
Many companies make clones of IBM‟s Personal Computers which are often called 

compatibles. IBM compatible can use hardware and software designed for the IBM PC. The 

internal architecture of IBM compatible is similar to IBM PC. The examples of IBM 

compatible computers are EPSON, ASER, etc. 

 

1.3.10-Apple/Macintosh 
Apple/Macintosh Company is also one of the largest personal computer manufactures, 

located in California. It was establish in 1976. The internal architecture of these computers is 

totally different from that of IBM. They have their own software. Apple Company 

manufactured a new brand of computer popularly known as Macintosh in 1984. Macintosh 

became notable for popularizing the graphical user interface. The operating system produced 

by Apple Company for their Macintosh is called Mac OS. 

 

 

1.4-Anatomy of Digital Computer 
1.4.1-Components of a Digital Computer 
A digital computer consists of four major components. They are  

1. Input devices 

2. Output devices 

3. Central Processing Unit 

4. Auxiliary Storage unit 

 

 

 

 

 

 

 

 

 

 

 

 

Figure1.1-Block diagram of digital computer with its major elements 
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1.4.2-Input devices 

Input device provides an interface 

between the users and the 

machine, for inputting data and 

instruction into the computer 

memory. One of the most 

common examples is the 

keyboard. Some common input 

devices are listed below. 

 Keyboard 

 Mouse 

 Light pen 

 Scanners 

 Microphone 

 Communication devices 

 

1.4.3-Output devices 
Output device also provides an interface between the user and the machine. They transfer the 

results (processed data) from computer‟s memory and present to users. A common example is 

visual display unit (monitor) of a personal computer. Some of the common output devices 

are:  

 Display screen 

 Printer 

 Plotter 

 Communication devices 

 Secondary Storage Devices 

 

1.4.4-Input/Output Devices 
CD and DVD drives, USB drives, hard disk drives and floppy disk drives are known as 

input/output, or I/O, devices. They are not only output devices, but are also used as storage 

and input devices. The computer sends data to the drive, where it is stored and can be later 

retrieved. CDs and DVDs are both types of optical discs that stores data in a digital format. 

Data is placed on the disc, using a laser writer that embeds the data into the disc‟s coating. 

 

1.4.5-Buses 
A bus is a subsystem that transfers data or power between computer components inside a 

computer. The basic function of a computer is program execution. When a program is 

running the executable binary file is copied from the disk drive into memory. The process of 

program execution is the retrieval of instructions and data from memory, and the execution of 

the various operations. 

 

 

1.4.5-The Central Processing Unit 
The Central Processing Unit (CPU) is considered the brains of the computer. The CPU plugs 

into the motherboard, which is a central connector point for all devices within the computer. 

Any commands or functions are calculated within the CPU. Processor (CPU) organizes and 

carries out instructions (execute program instructions). In a PC, the processor usually consists 

of one or more microprocessors, which are silvers of silicon or other material etched with 

many tiny electronic circuits. Microprocessor is connected to a circuit board called 

motherboard. 

 

 

 

The CPU also called processor has two components: 
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 Control Unit  

 Arithmetic Logic Unit. 

 

 

The arrows in the above figures may represent 

data as well as control information flow. 

The functions of the processor are 

 CPU controls the use of the main storage 

to store data and instruction. 

 CPU can perform arithmetic calculations 

such as addition subtraction etc. 

 CPU controls the sequence of operations. 

 CPU gives commands to all parts of the computer system. 

 CPU carries out processing 

 

ALU  

ALU consist of circuits which performs arithmetical and logical operations. Arithmetical 

operation includes addition, subtraction, division, and multiplication. Logical operation 

include comparisons, such as determining whether 1 number is less than, or greater than or 

equal to another number. The ALU includes a group of resisters- high speed memory 

locations built directly into the CPU that are to hold the data currently being processed 

 

Control Unit 

The control unit directs electronic signals between memory and the ALU, and between the 

CPU and input/output devices. It controls all the other devices connected the CPU, i.e. Input 

devices, Output devices, Auxiliary Memory etc. Hence, the control unit acts as the nerve 

center of the computer. The control unit upon receiving an instruction decides what is to be 

done with it. That is, whether it is to be sent to the ALU for further processing or to the 

output devices or to the memory etc. In other words the control unit coordinates and controls 

all hardware operations.  

 

1.4.6-The Main Memory Unit (Primary Storage) 
Memory is an area inside computer where data and instructions are held. The main memory is 

also known as primary memory is a combination of RAM and ROM. 

Physically it consists of chips either on the motherboard or on a small circuit board attached 

to the motherboard. This electronic memory allows the CPU to store and retrieve data very 

quickly. When a computer is instructed to execute a program, it picks up the first instruction 

from the main memory and executes it, then picks up second instruction and execute it, and 

so on. The result of the program are also stored in the memory temporally before being used 

again or transferred to devices outside the main memory. 

 
RAM (random –access memory) 

RAM is called random access memory also known as main 

memory. User can read from or write into any location in the 

RAM. It requires a steady flow of electricity to maintain it‟s 

contents. Any information stored in this area is lost when the 

power supply is switched off. The purpose of RAM is to hold 

programs and data while they are in use. Physically, RAM consists of some chips on a small 

circuit board. Inside RAM there are locations to store data and information, each location of 

memory has it‟s own address known as memory address. 

 
ROM (read-only memory) 

ROM is nonvolatile read only memory. ROM refers to special memory used to store 

programs that boot the computer and perform diagnostics. User cannot write on 

ROM.Usually in this kind of memory is done at factory. ROM contains most basic 

ALU 

CU 

MAIN 

MEMORY 

CPU 
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instructions that computer uses (check memory, check hardware devices, and check for OS 

on the computer disk drive). Once data has been written onto a ROM chip, it cannot be 

removed and can only be read. Unlike RAM, ROM retains its contents even when the 

computer is turned off.  
 

PROM (programmable read-only memory) 

A PROM is a memory chip on which data can be written only once. Once a program has been 

written onto a PROM, it remains there forever. Unlike the RAM, PROMs retain their 

contents when the computer is turn off. 

 The difference between a PROM and a ROM (read-only memory) is that a PROM is 

manufactured as blank memory, whereas a ROM is programmed during the manufacturing 

process. To write data onto a PROM chip, you need a special device called a PROM 

programmer or a PROM burner. The process of programming a PROM is sometimes called 

burning the PROM. 

 

Volatile memory: Memory which lose their contents when the computer power is shut off. 

RAM is an example of volatile memory. 

 

Nonvolatile memory: Memory which always hold their contents even the computer power is 

shut off. ROM is an example of nonvolatile memory. 

 

1.4.7-Auxiliary Memory (Mass Storage Devices) 
The auxiliary memory (mass storage device), also known as the secondary memory is an 

external (to CPU) memory. Auxiliary memory holds data that is not currently being used by 

computer. The secondary memory is permanent in nature, i.e., the information stored in these 

device is not lost unless specifically deleted. It stores data for further processing. They are 

also used in transferring data or programs from one computer to another.  

All computers require some kind of mechanism to store and retrieve data. Storage of 

information in primary memory is governed by the existence of a power source. As long as 

the machine is on, and electricity is flowing through the machine, information is stored in 

main memory. When the power is terminated, all information in main memory disappears. 

The internal primary memory of the computer may not be large enough to hold all the 

required instructions and data. So, we require additional storage facilities to store the 

information and retrieve it as and when required. This is possible through the use of 

secondary storage. 

There are two major types of auxiliary storage devices. 

1. Magnetic  storage device 

2. Optical storage device 

 

 Distinction between main memory and secondary memory 

1. There is more space in storage than in memory. 

2. Storage retains it‟s contents when the computer is turned off, but programs or data inside 

the memory is lost when the computer is shut down. 

3. Storage is cheaper than memory 

 

1.4.8-Magnetic storage 
Magnetic storage devices work by polarizing tiny pieces of iron on the magnetic medium. 

The surface of diskettes, hard disk, and magnetic tape are all coated with a magnetically 

sensitive material (usually iron oxide) which reads to a magnetic field. Since the surfaces of 

disks and magnetic tapes are coated with millions of tiny iron particles, digital data can be 

stored on them and each of these particles can act as a magnet, taking on a magnetic field 

when subjected to an electromagnet. All magnetic storage medium consists of read/write 

heads which can produce an electromagnetic field while current is passed through. The 

shifting of alignment polarities would indicate logic 1, but no change in polarity would 

indicate logic 0. 
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The most common magnetic storage devices are 

 Floppy Diskettes 

 Hard disks 

 Removable hard disks 

 Magnetic tape 
 

1.4.9-Optical disks 
Optical disks are a storage medium from which data is read and to which it is written by 

lasers beams. They can store much more data up to 10 gigabytes. A laser uses a concentrated, 

narrow beam of light, focused with lenses, prisms, and mirrors. 

The most common optical storage devices are 

 CD-ROM 

 WROM 

 Magneto-optical disks 

 

 

1.5-Introduction to Computer Software 
Computer software, or just software, is a collection of computer programs and related data 

that provide the instructions for telling a 

computer what to do and how to do it. In 

other words, software is the general term 

for various kind of programs used to 

operate and manipulate computers and 

peripheral devices. Software is necessary 

for the computer system to work at the 

most optimal level. Software enables the 

hardware to operate. Without software the 

computer cannot do anything.  

Software falls into three major categories. 

1. System software 

2. Programming software 

3. Application software 

 

1.5.1- System Software 
System software is computer software 

designed to operate the computer 

hardware and to provide a platform for 

running application software. For example, operating systems and network management 

programs serve as a vital software interface between computer networks and hardware and 

application programs. 

. 

System software is responsible for managing a variety of independent hardware components, 

so that they can work together harmoniously. Its purpose is to unburden the application 

software programmer from the often complex details of the particular computer being used, 

including such accessories as communications devices, printers, device readers, displays and 

keyboards, and also to partition the computer's resources such as memory and processor time 

in a safe and stable manner. 

 

The most basic types of system software are: 

 Device drivers provide basic functionality to operate and control the hardware connected 

to or built into the computer.  

 The operating system: It is the first layer of software loaded into computer memory 

when it starts up. As the first software layer, all other software that gets loaded after it 

depends on it for various common core services. An operating system (OS) is a set of 

software tools designed to make optimum use of a computer, which allows the parts of a 

End Users 
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computer to work together by performing tasks like transferring data between memory 

and disks or rendering output onto a display device. It also provides a platform to run 

high-level system software and application software. The primary purpose of Operating 

System is to maximize the productivity of computer system by operating it in the most 

efficient manner. OS controls the equipment resources of computer such as, processors, 

main storage, secondary storage, I/O devices and files. Windows, Dos, Unix, O/S2 are 

some of commonly used operating system. 

 

Following are most common functions of OS in the operation of a computer system. 

 User Interface: Provides a user interface for system and network communications 

with users. 

 Resource management: Managing the hardware resources of a computer system. 

 Task (Jobs) management: Managing the tasks or jobs waiting to be processed a 

computer must accomplish. It recognizes the jobs, identifies their priorities, priorities, 

determines whether the appropriate main memory and secondary storage capability 

they require is available, and finally runs each job at the appropriate moment. 

 Bach processing: Data are accumulated and processed in groups.  

 Virtual storage: The capacity to increase main memory without actually increasing 

its size.  

 File management: It is responsible for creation and deletion of files and directories. It also 
organizes, stores, retrieves, names, and protects all the files.  

 Device Management: It manages all the devices of the computer system such as printers and 

modems. If any device fails, it detects the device failure and notifies the same to the user. 

 Data recovery: Data recovery utility program can recover data files that have been 

mistakenly deleted.  
 Security Management: Protects system resources and information against destruction and 

unauthorized use. 
 Disk Management: Disk management program includes various system software like 

disk defragmenter, data compressor and disk formatting tools. De-fragmentation 

implies putting fragments of files in a sequential order onto the disk which reduces the 

time to access the file. 

 Virus Protection: Anti-virus programs are essential system utilities for a computer 

system functioning in a network. They provide the security to the system form viruses 

that can damage the computer system. 

 Disk Cleanup: To keep a computer running smoothly, regular maintenance is vital. 

Therefore, one should use the disk cleanup utility, which easily determines which files 

on hard drive are no longer needed, then delete those files. 

 Utilities and other functions: that provides miscellaneous support services. 

 

 

Following are some examples of system software 

 Utility software: Utility is a program which helps to analyze, configure, optimize and 

maintain the computer and performs a very specific task, usually related to managing 

system resources. OS contain a number of utilities for managing disk drives, printers, and 

other devices. 

 

 Network Management Software: Network management software offers comprehensive 

performance and fault management for networks and servers. It monitors networks for 

technical problems caused by overloaded servers, by crashed connections or by the users. 

Network monitoring software helps to control network usage or server capacity and 

availability. 

 

 Database Management Systems: Database is a structured collection of data. A computer 

database relies on database software to organize the data and enable the database users to 

achieve database operations. Database software allows the users to store and retrieve data 

from databases. Examples are Oracle, MS. Access, etc. 
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 Application Servers: Application server provide middleware interface between an 

operating system and the application programs of users. Middleware is software that 

helps diverse software applications and networked computer systems exchange data and 

work together more efficiently.  

 

 Performance and Security Monitors: Performance monitors are programs that 

monitor and adjust the performance and usages one or more computer systems to keep 

them running efficiently. Security monitors are packages that monitor and control the 

use of computer systems and provide warning messages and record evidence of 

unauthorized use of computer resources. 

 

1.5.2-Programming Software 
A programming language/software is an artificial language designed to communicate 

instructions to a machine, particularly a computer. Programming languages can be used to 

create programs that control the behavior of a machine and/or to express algorithms precisely.  

 

Programming software usually provides tools to assist a programmer in writing computer 

programs, and software using different programming languages in a more convenient way. 

The tools include compilers, debuggers, interpreters, assembler, programming editor, 

e.tc. 
 

1.5.3-Application Software 
Application software, also known as an application is computer software designed to help 

the user to perform specific tasks. Application software ranges from games, calculators, and 

word processors (document creating programs), to programs that “paint” images on screen 

(image editors). Applications represent real world tasks. They can be easily divided by 

looking at exactly what function they serve. Examples include enterprise software, 

accounting software, office suites, and graphics software and media players. Many 

application programs deal principally with documents. There is a broad category of 

application software. In general, application software is further classified into following two 

categories. 

1. General Purpose Application Programs 

 Word Processing Software 

 Spreadsheet Software 

 Image Processors and Image Editors 

 Presentation Software 

 Multimedia Software 

 Web Browsers 

 Electronic Mail 

 Personal Information Managers 

 Groupware 

2. Application-Specific Programs 

 Transaction Processing  

 Enterprise Resource Planning Application 

 Electronic Commerce 

 Science and Engineering Software 

 Education Software 

 Entertainment Software 

 Geographical information system (GIS) 

 

Word Processing Software: This software enables the users to create and edit documents by 

electronically processing text data. The most popular examples of this type of software are 

MS-Word, WordPad, Notepad and some other text editors. Word Processing Packages also 

provide other helpful features like a spelling checker capability, and thesaurus feature helps 
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you find better choice of words to express ideas. You can also suggest grammar and 

punctuation errors, as well as suggest possible improvements in your writing styles, graphics, 

photos, and colors on each page. 

 

Word processors vary considerably, but all word processors support the following basic 

features: 

 Insert text 

 Delete text 

 Cut and Paste 

 Copy 

 Page Size and Margins 

 Search and Replace 

 Word Wrap 

 Print 

 

Word processors that support only these features (and many few others) are called text 

editors. Most word processors, however, support additional features that enable you to 

manipulate and format documents in more sophisticated ways. Advanced word processors 

support following features. 

 File management 

 Font specification 

 Graphics 

 Footnotes and cross-References 

 Headers and Footers 

 Page Numbering 

 Layout 

 Macros 

 Merges 

 Spell Checker 

 Tables of Contents and Indices 

 Thesaurus 

 Windows 

Spreadsheet Software: Spreadsheet software organizes data into a table of values arranged 

in rows and columns. Each value can have predefined relationship with other values. 

Spreadsheet software allows users to perform calculations, business analysis, planning and 

modeling. In a spreadsheet, each value is placed in a cell. You can define what type of data is 

in each cell and how different cells are depending on one another. Excel, Lotus 1-2-3 and 

Apple Numbers are some examples of spreadsheet software. They simulate paper worksheets 

by displaying multiple cells that make up a grid (worksheet of rows and columns). 

Developing a spreadsheet involves designing its format and developing the relationship that 

will be used in the worksheet. Most packages help you develop charts and graphics displays 

of spreadsheet results. 

 

Multimedia Software: They allow the users to create and play audio and video media. They 

are capable of playing media files. Audio converters, players, burners, video encoders and 

decoders are some forms of multimedia software. Examples of this type of software include 

Real Player and Media Player. 

 

Presentation Software: The software that is used to display information in the form of a 

slide show is known as presentation software. This type of software includes three functions, 

namely, editing that allows insertion and formatting of text, methods to include graphics in 

the text and a functionality of executing the slide shows. Today a number of software 

packages are available to the users to conceive, create and deliver visually stunning 

presentations. Microsoft PowerPoint and Adobe Flash are the best example of presentation 

software. 
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Image Processors and Image Editors: Image processors or graphics program enable you to 

create, edit, manipulate, add special effects, view, print and save images. An image editor is a 

specialized graphics program that provides a variety of special features for altering bitmap 

images. They provides features such as filter image, transform image, create image layers. 

Some examples of image editors are Adobe Photoshop, Corel Paint Shop Pro, etc. 

 

Web Browsers: Web browsers such as Microsoft Explorer, Netscape Navigator, Firefox, 

Opera, or Mozilla are software applications designed to support navigation through the point-

and-click hyperlinked resources of the World Wide Web and the rest of the Internet, as well 

as corporate intranets and extranets. Web Browsers are becoming the universal software 

platform from which end-users lunch information searches, e-mail, multimedia file transfers, 

discussion groups, and many other internet based applications. 

 

Electronic Mail: E-mail application has changed the way people work and communicate 

with one another by sending and receiving electronic messages and files attachment via the 

Internet or their organizations‟ intranets or extranets. Whenever you want to, you can read 

your e-mail by displaying it on your workstation. With a few minutes of effort a message to 

one or many individuals can be composed, sent, and received. 

 

Groupware: Group is software that helps workgroups and teams collaborate to accomplish 

group assignments. For example, groupware products like Lotus Notes, Novell GroupWise, 

and Microsoft Exchange support collaboration through e-mail, discussion groups and 

databases, scheduling, task management, data, audio, and video conferencing, and so on. 

Groupware products rely on the internet and the corporate intranets and externs to make 

collaboration possible on a globe scale by virtual teams located anywhere in the world.  

 

Educational Software: It has the capabilities of running tests and tracking progress. It also 

has the capabilities of collaborative software. It is often used in teaching and self-learning. 

 

Enterprise Resource Planning (ERP) Systems: Enterprise systems, also known as 

enterprise resource planning (ERP) systems provide an organization with integrated software 

modules and a unified database which enable efficient planning, managing, and controlling of 

all core business processes across multiple locations. Modules of ERP systems may include 

finance, accounting, marketing, human resources, production, inventory management and 

distribution. 

It is typically hosted on servers and provides simultaneous services to a large number of 

users, typically over a computer network.  Services provided by enterprise software are 

typically business-oriented tools such as online shopping and online payment processing, 

interactive product catalogue, automated billing systems, security, content management, IT 

service management, customer relationship management, resource planning, business 

intelligence, HR management, manufacturing, application integration, and forms automation. 

 

Geographical Information System (GIS): Data visualization is the study of the visual 

representation of data, meaning “information that has been abstracted in some schematic 

form, including attributes or variables for the units of information”. According to Friedman 

(2008) the "main goal of data visualization is to communicate information clearly and 

effectively through graphical means.  

Location-based data visualization employing geographical information system and 

information visualization provides an advanced means to assist with visual data exploration 

and decision making. An effective location-based data visualization system can significantly 

enhance the communication among decision-makers and facilitate the agreement on the most 

appropriate alternatives. 

 

Computer-Aided Design (CAD) is the use of computer technology and systems to design 

and create 2D and 3D virtual models of goods and products for the purposes of testing. CAD 
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software, or environments, provides the user with input-tools for the purpose of streamlining 

design processes; drafting, documentation, and manufacturing processes. CAD output is often 

in the form of electronic files for print or machining operations. CAD/CAM include various 

forms of engineering; industrial design and general manufacturing; many disciplines of 

science, e.g. mathematics, computer science and psychology; arts and creative design; bio-

medical areas; CAD/CAM enterprises dealing with large scale product management, multi-

national consulting and system building. 

 

 

1.6-Word Processor (Microsoft Office Word 2007) 
Basic Features to practice in lab 

Paragraph formatting, font formatting, managing layout of document, editing document, 

reviewing document (Track changes, Adding comments, Proofing). Inserting pictures, tables, 

shapes, hyperlink, header, footer, page number, Watermark, Footnote, caption, text box, word 

art, equations, symbol and chart. Table of Content, Mail Merge, Text wrapping and 

Templates. 

 

 

1.7-Presentation Tools (Microsoft Office PowerPoint2007) 
Basic Features to practice in lab 

Formatting font, paragraph; inserting new slides, pictures, charts shapes, header footer, word 

art, date and time, slide number; page setup, slide orientation; using different themes for 

slide; animations: slide transition, custom animation; Slide show; reviewing slides. 

 

 

1.8-Microsoft Word Shortcut Keys 
Keyboard shortcuts can save time and the effort of switching from the keyboard to the mouse 

to execute simple commands. Print this list of Word keyboard shortcuts and keep it by your 

computer for a quick reference. 

 

Document actions Keystroke 

Open a file CTRL+O 

New file CTRL+N 

Close a file CTRL+W 

Save As F12 

Save 
CTRL+S or 

SHIFT+F12 

Print Preview CTRL+F2 

Print CTRL+P 

Show/Hide paragraph 

symbols 
CTRL+* 

Spelling and grammar F7 

Help F1 

Find CTRL+F 

Replace CTRL+H 

Go To CTRL+G 

 

Cursor movement Keystroke 

Select all - entire 

document 
CTRL+A 

 

Text Style Keystroke 

Font face CTRL+SHIFT+F 

Font size CTRL+SHIFT+P 

Bold CTRL+B 

Italics CTRL+I 

Underline CTRL+U 

Double underline CTRL+SHIFT+D 

Word underline CTRL+SHIFT+W 

All caps CTRL+SHIFT+A 

Change case SHIFT+F3 

Subscript CTRL+= 

Superscript CTRL+SHIFT+= 

Make web hyperlink CTRL+K 

 

Tables Keystroke 

Go to next cell Tab 

Go to previous cell SHIFT+Tab 

Go to beginning of 

column 
ALT+PageUp 
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Select from cursor to 

beginning of line 
SHIFT+Home 

Select from cursor to end 

of line 
SHIFT+END 

Go to beginning of line HOME 

Go to end of line END 

Go to beginning of 

document 
CTRL+Home 

Go to end of document CTRL+End 

 

Formatting Keystroke 

Cut CTRL+X 

Copy CTRL+C 

Paste CTRL+V 

Undo CTRL+Z 

Redo CTRL+Y 

Format painter CTRL+SHIFT+C 

Left alignment CTRL+L 

Center alignment CTRL+E 

Right alignment CTRL+R 

Justified CTRL+J 

Delete previous word CTRL+Backspace 

Apply bulleted list CTRL+SHIFT+L 

Indent CTRL+M 

Page break CTRL+Enter 
 

Highlight to 

beginning of column 
ALT+SHIFT+PageUp 

Go to end of column ALT+PageDown 

Highlight to end of 

column 
ALT+SHIFT+PageDown 

Go to beginning of 

row 
ALT+Home 

Highlight to 

beginning of row 
ALT+SHIFT+Home 

Go to end of row ALT+End 

Highlight to end of 

row 
ALT+SHIFT+End 

Column break CTRL+SHIFT+Enter 

 

Miscellaneous Keystroke 
Copyright symbol - © ALT+CTRL+C 

Date field ALT+SHIFT+D 

Go to footnotes ALT+CTRL+F 

Thesaurus SHIFT+F7 

 

 

 

 

 

 

 

 

 

 

 

1.9-Applications of Computer Technology 
In less than a generation, computer technology has revolutionized business all over the world. 

Companies of every size now relay on computers to automate or assist virtually every aspect 

of commerce. Computers are essential for efficiency and responsiveness. Without computers 

to provide the accurate, up-to-the-second information needed to make strategic decisions and 

manage production; many companies would find it impossible to meet the challenge of global 

competition. 

Business and Industry: Computers are flexible tools that most people in the business 

community use them every day. Office workers use them to write letters, keep employ 

rosters, create budgets, communicate with coworkers, find information, manage projects, and 

so on. Computers are also vital in accounting. 

 

Medicine: In medicine today, computers are used for diagnosing illnesses and monitoring 

patients at their beside to robotic surgical assistant. One of the most interesting is 

computerized diagnostic equipment that is so small it can be swallowed. 

 

Education and Training: Nowadays computer is as essential to the learning processes as 

books, paper, and pens. In the classroom, students use computers to develop project, prepare 

reports, and gather information from electronic resources around the world. Computerized 

tutorials can teach, test for understanding, and re-teach based on how much the student has 

learned. 
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Entertainment: Computers are used for looking movies, listening music, playing 3-D games, 

chatting with friend and relatives, advertising, arts and many more. Musician can use MIDI 

(Musical Instrument Digital Interface) to combine or create sounds electronically, either in 

the recording studio or during live performances. 

 

Science: The scientific community uses computers to do research and to exchange with 

colleagues around the world. Scientists also use computers to simulate complex events, such 

as predicating how earthquakes will affect building or how will change weather patterns. 

 

Engineering: Engineers and architects use computers to design objects and structures with 

the help of CAD (Computer-Aided design) techniques. Specialized CAD systems are 

available for designing almost anything from houses, cars, and buildings. Knowledge of CAD 

is now required for many engineering jobs.  Project management software are used to manage 

complex engineering project and EDI technology is used to transfer data from one place to 

another. 

 

Manufacturing: In some factories, computers control virtually everything. For example, 

consider a power plant that generates steam for electricity. In this kind of factory, a computer 

monitors pressures and temperature at hundreds of critical points through the plant. 

Automobile plants use robots to perform task such as painting, welding, and cutting, and 

bending sheet metal for body parts. 

 

Government: In U.S government uses computers to collect, process, and store vast amounts 

of information about it‟s citizens are through the social security administration, the bureau of 

census, internal revenue service. 

 

Military: Today military uses much more compact computers in a variety of ways aboard 

ships, submarines, and airplanes, as well as on battlefields and in certain weapons and 

satellites. 

 

Film industry: Computers are used in film to create special effects (Animate Object) and 

streamline the film editing process. 

Computer animation involves creating images of people or other creatures on a computer and 

then making the images appear to move against the real or computer generated background. 

For example a dinosaur in Jurassic Park was created using computer animation. Computer 

also plays a large role, in film editing which requires a huge variety of techniques. 



19 

Unit 2: Accounting through MS Excel [LH 15 Hrs] 

2.1-An overview concept of Spread Sheet application 
Spreadsheet application software package organizes data into a table of values arranged in 

rows and columns. Each value can have predefined relationship with other values. 

Spreadsheet software allows users to perform data calculations, data manipulations, data 

analysis, business analysis, generating charts and reports, planning, modeling etc. In a 

spreadsheet, each value is placed in a cell. We can define what type of data is in each cell and 

how different cells are depending on one another. Once we have defined the cells and 

formula for linking them together, we can enter data and analyze the result. Furthermore, we 

can simulate the result by modifying the selected data values to see how the result changes 

accordingly.  

 

Excel, Lotus 1-2-3 and Apple Numbers are some examples of spreadsheet software. MS 

Excel is the most popular spreadsheet application. They simulate paper worksheets by 

displaying multiple cells that make up a grid (worksheet of rows and columns). Developing a 

spreadsheet involves designing its format and developing the relationship that will be used in 

the worksheet. Most packages help you develop charts and graphics displays of spreadsheet 

results. Spreadsheet applications have a wide range of uses-from family business to corporate 

earnings statements. 

 

2.2-An overview concept of MS Excel and possible uses of MS 
excel in accounting. 
2.2.1-Introduction 
Microsoft Excel is an application software developed and manufactured by Microsoft 

Corporation that allows users to organize, format, and calculate data with formulas using a 

spreadsheet system broken up by rows and columns. Microsoft Excel usually comes bundled 

with Microsoft Office and is compatible with other applications offered in the suite of 

products.  

 

Microsoft Excel is the most popular spreadsheet program on the market today. You can use 

the program to track and manage large quantities of data, such as inventories, price lists, 

expenses and expenditures, and much more. You can even use Excel as a database, entering 

and sorting records. 

 

Microsoft Office Excel was designed to support accounting functions such as budgeting, 

preparing financial statements and creating balance sheets. It comes with basic spreadsheet 

functionality and many functions for performing complex mathematical calculations. It also 

supports many add-ons for activities such as modeling and financial forecasting, and 

seamlessly integrates with external data to allow you to import and export banking 

information and financial data to and from other accounting software platforms. 

 

2.2.2-Budgeting and Statements 
Microsoft Office Excel ships with templates for creating budgets, cash-flow statements and 

profit-and-loss statements, which are some of the most basic documents used in accounting. 

In addition, you can download more complex budgeting and statement templates from the 

Office website, or purchase specialized templates from third-party vendors and install these 

in the application. If you need to create complex or custom budgets or financial statements, 

you can either customize an existing template and re-use its elements, or create one from 

scratch using the functionality built into Excel. 

 

2.2.3-Spreadsheets 
Performing line calculations is a basic accounting task, and Excel spreadsheets are designed 

to contain data in a tabular format that supports both in-line and summation calculations, 
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replacing the need for ticker tape and special accounting calculators. The data in the 

spreadsheet is reusable and storable, making Excel more flexible than an accounting 

calculator for performing simple calculations and summations. Additionally, you can create 

charts and graphs from the spreadsheet data, creating a media-rich user experience and 

different views of the same data. You can also use add-ons to mine the data and create 

models and financial forecasts. 

 

2.2.4-Present Data 
You can use Excel‟s formatting tools to make your spreadsheet data easier to read and 

interpret. For example, you can add shading to cells, change the number format, or change 

the font and size of your data. You can present your worksheet data to others using charts and 

graphs. Excel‟s graphing and charting tools make it easy to turn your data into meaningful 

visuals, such as pie charts, bar charts, and more. 

 

2.2.5-External Data 
You can import data from many different data sources into Excel. This is especially useful for 

accounting as you can pull sales data, banking data and invoices from many sources into one 

central workbook to support your accounting activities. The data can be stored in different 

databases and file formats prior to importing, allowing you to access data from many 

different areas of your business without having to do additional data entry. 

 

2.2.6-Integration 
Excel integrates with many popular accounting software applications. For example, you can 

use the wizards that ship with your preferred accounting software package to map Excel 

spreadsheets to your accounting data so you can perform push and pull data operations from 

both Excel and your accounting package on demand. 

 

 

2.3-Brief Guide for Using MS Excel 
 

2.3.1-Excel Basic 
Basic Features 

 An Introduction to Excel  

 Start and Close Excel 

 Navigate the Excel Program Window 

 Understanding the Ribbon, Galleries, and Contextual Tools 

 Change Views  

 Customize the Quick Access Toolbar  

 Display Task Panes  

 Find Help 
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2.3.2-Workbook Fundamentals 
Basic Features 

 Start a New Workbook File 

 Save a Workbook 

 Publish a Workbook as an Excel Binary 

 Workbook File 

 Open an Existing Workbook 

 Close a Workbook 

 Delete a Workbook 

 Arrange Workbook Windows 
o Open two or more workbooks. 

o Click View. 
o Click Arrange All. The Arrange Windows dialog box appears. 

o Click a display mode (changes to). 

-Tiled arranges the workbooks like mosaic tiles across the screen. 

-Horizontal arranges the workbooks stacked horizontally. 
-Vertical arranges the workbooks vertically. 

-Cascade arranges the workbooks stacked on top of each other in a cascading display. 

 Hide or Show a Worksheet 
o Right-click the tab for the worksheet you want to hide. 

o Click Hide. 

o Right-click the tab area. 
o Click Unhide. The Unhide dialog box appears. 

o Click the worksheet you want to unhide. 

o Click OK. 
o The worksheet reappears. 

 

2.3.3-Entering Data in a Worksheet 
Basic Features 

 Enter Data 

 Turn On Text Wrapping 

 Resize Columns and Rows 

 Select Cells 

 Enter Data with AutoFill 

 Work with AutoCorrect 

 Edit Data 

 Check Spelling in a Worksheet 

 

You can enter data into any cell within the worksheet. When you click a cell, it immediately 

becomes the active cell in the worksheet, and any data you type appears within it. You can 

type data directly into the cell, or you can enter data using the Formula bar. 

 

Data can be text, such as row or column labels, or numbers, which are called values in Excel. 

Formulas are also values. Excel automatically left-aligns text data in a cell and right-aligns 

values. By default, Excel also considers numerical dates and times that you enter to be values, 

and assigns right alignment. 

 

AutoFill a Text Series 

1- Type the first entry in the text series. 

2- Click and drag the cell‟s fill handle across or down the number of cells you want to fill.  

3- Release the mouse button. 

Note:- You can also use AutoFill to copy the same text to every cell you drag over if the text 

is not part of a commonly used set, such as the months of the year. 

 

Monday 

Tuesday 
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Wednesday 

Thursday 

Friday 

 

 When you make a cell active in the worksheet, a small fill handle appears in the lower-right 

corner of the selector. You can use the fill handle to create an AutoFill series. 

 

AutoFill a Number Series 

1- Type the first entry in the number series. 

2- In an adjacent cell, type the next entry in the number series. 

3- Select both cells. 

4- Click and drag the fill handle across or down the number of cells you want to fill. 

 

AutoCorrect feature 

You can use the AutoCorrect feature to quickly correct text you commonly misspell. For 

example, if you continually misspell the word “autumn” as “autumm,” you can add the word 

to the AutoCorrect dictionary. The next time you mistype the word, AutoCorrect fixes your 

mistake for you. 

 

Add a Misspelling 

 

1- Click . 

2- Click Excel Options. The Excel Options window appears. 

3- Click Proofing. 

4- Click AutoCorrect Options. 

 

Perform editing 

You can perform editing tasks to the data in your worksheets. For example, you might want 

to change the number values you entered, or add additional text to a cell. 

 

1-Double-click the cell containing the data you want to edit. 

2-Make necessary updates. 

 

You can also edit the data in the selected cell by making changes to the data as it appears in 

the Formula bar. 

 

2.3.4-Working with Worksheets 
Worksheets are where all the action takes place in Excel. You use worksheets to enter and 

edit data, perform calculations, and more. 

 

Basic Features 

 Understanding Worksheet Structure  

 Navigate Worksheets 

 Name a Worksheet 

 Add a Worksheet 

 Delete a Worksheet 

 Move a Worksheet 

 Copy a Worksheet 

 Format Worksheet Tab Color 

 

Columns and Rows 

Worksheets are formatted as a grid formed by columns and rows. Each worksheet has 16,384 

columns and 1,048,576 rows. Every column and row has a unique identifier. Columns are 

labeled by letters arranged alphabetically, and rows are numbered. 
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Cells and Cell Addresses 

Every intersection of a column and a row creates a cell. Cells are the receptacles for your 

Excel data. Every cell has a unique name, also called an address or cell reference, in the 

Excel worksheet. Cell names consist of the column and row number, with the column always 

listed first. For example, cell A1 is the first cell in the worksheet. The next cell to the right is 

B1. 

 

Active Cell 

The active cell in a worksheet is always surrounded by a highlighted border, called the 

selector. The Name box, located on the far left side of the Formula bar, always displays the 

name of the current cell. 

 

Cell Ranges 

As you work with data in a worksheet, you can group related data into a range. A range is 

simply a group of related cells that you can connect. A range can also be a single cell or an 

entire worksheet. By grouping cells into a range, you can apply formatting or printing to the 

entire collection, or move or copy the range data at once. Ranges are particularly useful when 

you begin creating formulas that reference groups of cells. 

 

Worksheet Tabs 

By default, every Excel workbook starts out with three worksheets. Each worksheet is 

identified by a tab at the bottom of the sheet. The active worksheet always appears at the top 

of the stack. You can add more or less worksheets as needed using the Insert Worksheet tab 

to the right of the three worksheet tabs. You can also give your worksheets unique names to 

better identify their content. 

 

2.3.5-Calculating Data with Formulas and Functions 
Formulas and functions are the real driving force of Excel‟s spreadsheet capabilities. You can 

use formulas to perform all kinds of calculations on your Excel data. You can build formulas 

using mathematical operators, values, and cell references. For example, you can add the 

contents of a column of monthly sales figures to calculate a total number of sales.  

 

Basic Features 

 Understanding Formulas 

 Create Formulas 

 Reference Absolute and Relative Cells 

 Copy Formulas  

 Name Cells and Ranges  

 Reference Ranges in Formulas 

 Reference Cells from Other Worksheets 

 Understanding Functions 

 Apply a Function 

 

Formula Structure 

Ordinarily, when you write a mathematical formula, you write out the values and the 

operators, followed by an equal sign, such as 2 + 2 =. In Excel, formula structure works a bit 

differently. All Excel formulas begin with an equal sign (=), such as =2+2. The equal sign 

immediately tells Excel to recognize any subsequent data as a formula rather than a regular 

cell entry. 

 

Referencing Cells 

Although you can enter specific values in your Excel formulas, you can also easily reference 

data in specific cells. For example, you can add two cells together or multiply the contents of 

one cell by a value. Every cell in a worksheet has a unique address, also called a cell 

reference. By default, cells are identified by a specific column letter and row number, so cell 
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D5 identifies the fifth cell down in column D. To help make your worksheets easier to use, 

you can also assign your own unique names to cells. For example, if a cell contains a figure 

totaling weekly sales, you might name the cell Sales. 

 

Cell Ranges 

A group of related cells in a worksheet is called a range. Cell ranges are identified by their 

anchor points, the upper left corner of the range and the lower right corner of the range. The 

range reference includes both anchor points separated by a colon. For example, the range 

name A1:B3 includes cells A1, A2, A3, B1, B2, and B3. You can also assign unique names 

to your ranges to make it easier to identify their contents. Range names must start with a 

letter or underscore and can include uppercase and lowercase letters. Spaces are not allowed 

in range names. 

 

Mathematical Operators 

You can use mathematical operators in Excel to build formulas. Basic operators include the 

following: 

Operator  Operation 

+   Addition 

-   Subtraction 

*   Multiplication 

/   Division 

%   Percentage 

^   Exponentiation 

=   Equal to 

<   Less than 

≤   Less than or equal to 

>   Greater than 

≥   Greater than or equal to 

<>   Not equal to 

 

Reference Absolute and Relative Cells 

Cell referencing is the method of using cell address in formula. The calculation in the 

worksheet is very effective by the use of cell referencing because any update of values in the 

cell automatically updates the result in the other cells. There are three types of cell 

referencing. 

 Relative cell reference 

 Absolute cell reference 

 Mixed cell reference 

 
By default, Excel treats the cells you include in formulas as relative locations rather than set locations 
in the worksheet. This is called relative cell referencing. For example, when you copy a formula to a 

new location, the formula automatically adjusts using relative cell addresses. If you want to address a 

particular cell location no matter where the formula appears, you can assign an absolute cell 

reference. Absolute references are preceded with a $ sign in the formula, such as =$D$2+E2. A 

mixed cell reference combines both relative and absolute cell references. We can effectively lock 

either the row or the column in a mixed reference. 

 
Assign Absolute References 

1- Click the cell containing the formula you want to change. 
2- Select the cell reference. 

3- Press F4. 

Note: - You can also type in the dollar signs to make a reference absolute. Excel enters dollar 

signs ($) before each part of the cell reference, making the cell reference absolute. 

 

When would I use absolute cell references? 
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You can use absolute referencing to always refer to the same cell in the worksheet. For 

example, perhaps your worksheet contains several columns of pricing information that refer 

to one discount rate disclosed in cell G10. When you create a formula based on the discount 

rate, you want to make sure the formula always refers to cell G10, even if the formula is 

moved or copied to another cell. 

 

When would I use mixed cell references? 

You can use mixed referencing to reference different relative cells within the same row or 

column, such as $C6, which keeps the column from changing but leaves the row relative. If 

the mixed reference is C$6, the column is relative but the row is absolute. 

 

Copy a Relative Formula 

1- Click the cell containing the formula you want to copy. 

2- Click and drag the cell‟s fill handle across or down the number of cells to which you want 

to copy the formula. 

 

Excel copies the formula into each cell you drag over. In the case of relative cell referencing, 

Excel adjusts the formula relative to each cell into which you copy the formula. 

 

Name Cells and Ranges 

You can assign distinctive names to the cells and ranges of cells you work with in a 

worksheet, making it easier to identify the cell‟s contents. A range is simply a group of 

related cells, or a range can consist of a single cell. Naming ranges can also help you when 

deciphering formulas. 

 

Assign a Range Name 

1- Click the Formulas tab. 

2- Select the range you want to name. 

3- Click Name a Range. The New Name dialog box appears. 

4- Type a name for the range. 

5- Click OK. Excel assigns the name to the cells. 

 

Go to a Range 

1- Click the Name. 

2- Click the range name to which you want to move. Excel immediately jumps to the cells. 

 

Are there any rules for naming ranges? 

Range names must start with a letter or an underscore (_). After that, you can use any 

character, uppercase or lowercase, or any punctuation or keyboard symbols, while hyphens or 

spaces are not allowed in range names; instead, substitute a period or underscore. 

 

Reference Ranges in Formulas 

You can reference an entire group of cells in a formula by referencing the range name. This 

can speed up the time it takes to build a formula in a worksheet, and range names are much 

easier to remember than the default range names Excel assigns. 

 

1- Click the Formulas tab. 

2- Click the cell to which you want to assign a formula. 

3- Start or create the formula you want to apply. 

Note: See the section “Create Formulas” to learn more. 

4- When you are ready to insert a range into the formula, click Use In Formula. 

5- Click the range name. Excel automatically inserts the range name. 

6- Continue creating the formula as needed. 

7- Press Enter. 
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Reference Cells from Other Worksheets 

You can reference cells in other worksheets in your Excel formulas. When referencing 

data from other worksheets, you must specify the sheet name followed by an exclamation 

mark and the cell address, such as Sheet2!D12. If the sheet has a specific name, such as 

Sales, you must use the name along with an exclamation mark, followed by the cell or range 

reference, such as Sales!D12. If the sheet name includes spaces, enclose the reference in 

single quote marks, such as „Sales Totals!D12‟. 

 

Procedure 

1- Click the cell to which you want to assign a formula. 

2- Create the formula you want to apply. 

Note: See the section “Create Formulas” to learn more. 

3- When you are ready to insert a cell or range from another sheet into the formula, type the 

sheet name preceded by an exclamation point. 

4- Type !G7, where G7 is the cell address or range. You can continue creating the formula as 

needed. 

5- When finished, press Enter. The formula results appear in the cell. 

 

Understanding Functions 

If you are looking for a quicker way to enter formulas, you can tap into a wide variety of built-in 

formulas, called functions. Functions are ready-made formulas that perform a series of 

operations on a specified range of values. Excel offers over 300 functions you can use to 

perform mathematical calculations on your worksheet data. 

 

Because functions are formulas, all functions must start with an equal sign (=). Functions are 

also distinct in that each one has a name. For example, the function that sums data is called 

the SUM function, and the function for averaging values is AVERAGE. You can type 

functions directly into your worksheet cells or use the Formulas tab of the ribbon. 
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Apply a Function 

You can use functions to speed up your Excel calculations. 

 

1- Click the cell to which you want to assign a function. 

2- Click the Insert Function icon on the Formula bar. 

 

Note: You can also click the Formulas tab and click function icon. Excel inserts an equal 

sign automatically to denote a formula and displays the Insert Function dialog box. 

3- Click to select a category. 

4- Click the function you want to apply. 

5- Click OK. The Function Arguments dialog box appears. 

 

Note: After selecting a function, you can then apply the function to a cell or range of cells in 

your worksheet. You can use the Function Arguments dialog box to help you construct all the 

necessary components of a function. The dialog box can help you determine what values you 

need to enter to build the formula. 

 

6- Depending on the function‟s arguments, select the desired cells for each argument required 

by the function. 

 

Note: You can select a cell or range of cells directly in the worksheet, and Excel 

automatically adds the references to the argument. 

You can also type a range or cell address directly in the argument text box. The dialog box 

displays additional information about the function here. 

7- If needed, continue adding the necessary cell references to complete all of the function‟s 

arguments. 

8- When finished constructing the arguments, click OK. 

 

2.3.6-Rearranging Worksheet Data 
You can rearrange your worksheet data to improve the presentation of your worksheet 

information. 

Basic Features 

 Move and Copy Data  

 Delete Data or Cells  

 Add Columns and Rows 
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 Delete Columns and Rows  

 Center Data across Columns  

 Transpose Columns and Rows  

 Set Column Width and Row Height  

 Hide Columns and Rows  

 Freeze a Column or Row  

 Split a Worksheet into Panes 

 Find and Replace Data 

 

2.3.7-Formatting Worksheets 
You can make your worksheets more presentable by applying one or several of Excel‟s many 

formatting features. We can improve the appearance of your worksheet data by changing the 

font and size of the data, adding color and shading, and giving your worksheets a more 

professional, polished look. 

 

Basic Features 

 Apply Bold, Italics, and Underlining  

 Change the Font and Size  

 Change Number Formats 

 Increase or Decrease Decimals 

 Change Data Color  

 Apply Workbook Themes 

 Align Cell Data  

 Rotate Cell Data 

 Control Text Wrap  

 Add Borders 

 Add Background Color to Cells 

 Assign a Background to a Worksheet 

 Copy Cell Formatting 

 Apply a Style 

 Assign Conditional Formatting 

 

Assign a Background to a Worksheet 

You can add a photo background to a worksheet for added interest. For example, if your 

worksheet documents sales, you might add a picture of a product. 

 

1- Click the Page Layout tab. 

2- Click Background. 

Note: The Sheet Background dialog box opens. 

You can use the Look in to navigate to the folder or drive where the image is stored. 

3- Select the image you want to use as a background. 

4- Click Insert. 

Excel applies the image to the worksheet background. 

 

Copy Cell Formatting 

You can use the Format Painter feature to copy formatting to other cells in your worksheet. 

For example, perhaps you have applied a variety of formatting to a range of cells to create a 

certain look. 

 

1- Select the cell or range containing the formatting you want to copy. 

Note: See Chapter 3 to learn how to select cells. 

2- Click the Home tab. 

3- Click Format Painter ( ). 

To copy the same formatting multiple times, double-click. 
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4- Click and drag over the cells to which you want to copy the formatting. Excel immediately 

copies the formatting to the new cells. 

 

Apply a Style 
You can use a style to quickly assign formatting throughout a workbook. A style is a collection of 

formatting, whether you define a font and size or a background color. 

 

1- Select the cell or cells to which you want to apply a style. 

Note: See Chapter 3 to learn how to select cells. 

2- Click the Home tab. 

3- Click Cell Styles. 

The Style gallery opens. 

4- Click a style to apply it. 

 

Assign Conditional Formatting 

You can use Excel‟s conditional formatting feature to assign certain formatting only when the 

value of the cell meets the specified condition. 

 

1- Select the cell or range to which you want to apply conditional formatting. 

Note: See Chapter 3 to learn how to select cells. 

2- Click the Home tab. 

3- Click Conditional Formatting. 

4- Click Highlight Cells Rules. 

Note that there are other rules you can apply from this menu, depending on what conditions 

you wish to highlight. 

5- Specify the operator you want to assign for condition 1. 

Note: The associated dialog box, such as Less Than, opens. If you need to select a cell or 

range, click here to minimize the dialog box and view more of the worksheet. 

 

Enter a value or text for the condition here. 

6- Choose a format to apply and Click OK. 

 

2.3.8-Communicating Information with Charts 
You can use charts to turn your spreadsheet data into instant, persuasive visual presentations. 

You can create dozens of different charts in Excel, from pie charts to bar charts and more. If 

you are new to using charts to visualize data, this section gives you an overview of how 

charts work in Excel. 
 

Basic Features 

 Understanding Excel Charts  

 Create a Chart with Galleries  

 Move and Resize Charts  

 Change the Chart Type 

 Change the Axes Titles 

 Manipulate 3-D Charts 

 Format Chart Objects  

 Add Chart Objects  

 Change the Chart Data 

 Format Charts with Layouts and Styles  

 

Data Series 

The foundation of any chart is the worksheet data you use to create the chart. Called a data 

series, chart data is the content of a group of related cells, such as one row or column of data 

in your worksheet. For example, to make a pie chart of monthly household expenses, your 

worksheet data needs to consist of columns and rows tracking expenses such as electricity, 
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gas, water, mortgage, groceries, and so on. You decide which cells to include in the chart, and 

Excel‟s chart tools can help you build a pie chart using the cell‟s contents and labels. 

 

Customize Charts 

You can customize any chart you create in Excel. You can make changes to the formatting of 

the chart text, change the chart type, re-plot the data, and much more. You can angle text, 

change text color, or adjust the colors and patterns of the bars and lines displayed in a chart. 

You can also add new chart elements, such as callouts, labels, and titles. Layout and Style 

galleries feature new to Excel 2007 offers easy-to-apply, predesigned formatting. 

 

 
 

 

 

 
 

Create a Chart with Galleries  
You can use the chart galleries to quickly assemble and create all kinds of charts in Excel. The 
galleries offer you a wide variety of charts. You can select the chart category and then the specific 

type you need for your data. 
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1- Select the range of data you want to chart. 

Include any headings and labels, but do not include subtotals or totals. 

2- Click the Insert tab. 

3- Click an item in the Charts group. 

The associated gallery opens. 

4- Click a chart sub-type. 

 

Note: The chart appears on your worksheet. Contextual tools (Design, Layout, and 

Format tabs) appear in the Ribbon. If you want to move the chart to its own sheet, click Move 

Chart on the Design tab and choose New Sheet. 

 

Can I select noncontiguous data to include in a chart? 

Yes. The data you select for a chart do not have to be adjacent to each other. To select 

noncontiguous cells and ranges, select the first range and then press and hold while selecting 

additional ranges to include. 

 
Move and Resize Chart 
You can move and resize an embedded chart on your worksheet. For example, you might want to 

reposition the chart at the bottom of the worksheet or resize it to make the chart easier to read. 
 

Move a Chart 

1- Click an empty area of the chart. Excel selects the chart and surrounds it 

with handles. 

2- Position the mouse over the edge of the chart, and it becomes a cursor with four arrows.  

You cannot move or resize charts you create on their own sheets. 

Move and Resize Charts 

3- Click and drag the chart to a new location on the worksheet. 

 

Resize a Chart 

1- Click an empty area of the chart. Excel selects the chart and surrounds it with handles. 

2- Click and drag a handle to resize the chart. 

 
Change the chart type 
You can change the chart type at any time to present your data in a different way. For example, you 
might want to change a bar chart to a line chart. 

 

1- Click an empty area of the chart to select the chart. 

2- Click the Design tab. 

3- Click Change Chart Type. 

The Change Chart Type dialog box appears. 

 

4- Click a new chart type. 

5- Click OK. 

 

Change the Axes Titles 

You can change the titles of the x- or y-axis on your chart. For example, you might prefer to 

give the axes more descriptive titles, or if your titles are too long, you might want to shorten 

the title text. You can change chart title information using the Edit Data Source dialog box. 

 

1- Select the chart you want to edit. 

2- Click the Layout tab. 

3- Click Axis Titles. 

4- Click Primary Vertical Axis Title or Primary Horizontal Axis Title. 

5- Select an axis type (for example, Vertical Title or Rotated Title). The title placeholder 

appears. 

6- Click and drag in the placeholder to select the placeholder text and enter new text. 
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7- Press Enter or click outside the placeholder to save the new title. Excel applies the new 

titles to the chart. 

 

Format Chart Objects 

You can change the formatting for any of the elements, called objects in Excel, contained 

within a chart. For example, you can change the background color or pattern for the plot area 

or change the color of a data series on the chart. 

 

1- Select the chart. The Chart Tool tabs become available. 

2- Click the Format tab. 

3- Click to select the chart object you want to edit. 

4- Click Format Selection. 

 

A Format dialog box appears. Depending on the chart object you want to edit, the options 

offered will vary. 

Note: For more about chart objects, see the section “Understanding Excel Charts.”  

5- Make any changes to the chart object, as needed. Depending on the chart object you edit, 

the dialog box offers different options. 

6- When finished with your edits, click Close. 

 

Add Chart Objects 

You can add additional objects to your charts, such as data labels, gridlines, or a legend. The 

Layout tab is where you access tools for adding and working with chart objects. 

 

1- Select the chart you want to edit. 

2- Click the Layout tab. 

3- Click an item in the Labels or Axes group of tools. 

4- Click the object you want to add. 

 

A drop-down menu offers options to display objects. In this example, both major and minor 

vertical gridlines are selected to be displayed. 

 

Change the Chart Data 

Whenever you make changes to the data referenced in your chart, the chart data is 

automatically updated. For example, if you change a value, the chart updates to reflect the 

new value. If you need to add more data to the chart, you can easily update the source cells.  

 

1- Select the chart you want to edit. 

Excel surrounds the chart with selection handles and marks the source data in the worksheet 

with a colored border. 

2- Click and drag the corner handle of the source range to add or subtract cells.  

 

Format Charts with Layouts and Styles 

In Excel 2007, new features offer you instant formatting of chart elements. Quick Layouts 

use sets of formatting for gridlines, labels, and settings, such as perspectives to quickly give 

your chart a new look. Styles apply preset color schemes and backgrounds to add instant 

design appeal. 

1- Select the chart. 

2- Click the Design tab. 

3- Click the Chart Layouts to scroll through chart layouts. 

4- Click a layout to apply it. 

5- Click to display all styles. 

6- Click a style to apply it. 
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2.3.9-Analyzing Worksheet Data 
You can use Excel as a database program to organize, sort, filter, and analyze lists of data. A 

database is a collection of related information. For example, an address book is a database list 

of names and addresses of your contacts. A television guide is also an example of a database, 

listing television programs, channels, and air times. You can create a variety of database lists 

in Excel to manage sales contacts, inventory, household valuables, and more. 
 

Basic Features 

 Understanding Database Lists 

 Create a Database Table  

 Add Records Using a Data Form 

 Search for Records  

 Set Data Validation Rules  

 Sort Records  

 Filter Data with AutoFilter 

 Analyze Data with a PivotTable  

 

Fields 

You use fields to break down your database list into manageable pieces. In Excel, fields are 

typically the columns you use to define each part of your list. For example, an address 

database includes fields such as name, address, and phone number. Field names, also called 

labels, appear at the top of a list. 

 

Records 

You use rows to enter each database entry for your list of data. Database entries are called 

records. For example, in an inventory database, a single row contains all the information 

about an item in the inventory. Each row represents one record in the database. 

 

Tables 

An entire database list of information is called a table. You can create multiple tables in 

Excel. For example, one table might list customers and addresses, and another might list 

product items and prices. You might pull information from two tables to create a third table, 

such as a table listing customers and the items they buy. 

 

Create a Database Table  

You can use an Excel worksheet to build a database to manage large lists of data. A database 

is simply a collection of related records, such as a phone directory, address list, inventory, 

and so on. After creating a database table, you can perform a variety of analysis, sorting, and 

filtering techniques on the data. 

 

Type Field Labels 

1- Click where you want to insert the first column. 

2- Type a field label. 

3- Press Tab. 

4- Type the next field label. 

5- Repeat steps 3 and 4 to continue entering as many field labels as your list requires. 

 

Enter Records 

1- Click in the first row beneath the field labels. 

2- Type the data for the first field. 

3- Press Tab. 

4- Type the next field data. 

5- Repeat steps 3 and 4 to continue filling in a complete record. 

6- Press Enter. Excel starts a new record for the table by moving automatically to the next 

row. 
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7- Repeat steps 2 to 6 to continue entering records for your table. 

 

Create a Table 

1- Select the data you want to turn into a database table. 

2- Click the Insert tab. 

3- Click Table. 

The Create Table dialog box opens. By default, the selected range appears here. If the range 

is not correct, you can select the correct cell references. 

Select this option ( changes to ) if necessary to include the headers in your table. 

4- Click OK. 

Excel turns the data into a table, fills the cells of the table with blue shading, and displays 

filter arrows ( ) for each field. 

 

Add Records Using a Data Form 

Another way to enter database records is to use Excel‟s Data Form. The Data Form is a handy 

dialog box you can use to type the data for each field in your table, one record at a time. You 

are less likely to enter wrong information into a field when using a form than when directly 

entering data into your worksheet cells. 

 

1- Enter a record in a row. 

2- Select the first cell of a record. 

3- Click Form on the Quick Access toolbar. 

Note: If your database has no records yet, a prompt box appears. Click OK to continue.  

The data entry dialog box opens. 

4- Click New. 

5- Type the data for the first field. 

6- Press Tab. 

7- Repeat steps 3 to 4 to continue filling in form fields. 

You can click New to enter another record. 

8- Click Close. 

Excel adds the record or records to the database list. 

 

How do I navigate through my records using a form? 

You can use the Data Form dialog box to navigate between all the records in your table. Click 

Find Prev to move backward through the table, or click Find Next to move forward. Any 

time you want to add a new record, click New and fill out the fields. 

 

What methods can I use to delete a record? 

You can open the Data Form dialog box and navigate to the record. Click the Delete button 

and confirm the deletion, and the record is gone. You can also click and drag your mouse 

across the fields of the record in the table on the Excel worksheet and then press Delete. 

You can edit your database table by making changes to the records. For example, you might 

need to change a record‟s details or delete a record you no longer need. You can edit cells, 

columns, and rows directly in the table or you can use the Data Form dialog box to make 

changes. 

 

Edit Records 

Change a Record 

1- Click anywhere in the table and then click Form on the Quick Access toolbar. 

The Data Form dialog box opens. 

2- Scroll to locate the record you want to edit. 

3- Click in the field you want to edit and then make your changes. 

You can double-click a field to highlight all the data. 

Click Find Prev or Find Next to navigate to the next record you want to change. 

4- Click Close. The record or records are changed. 
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Delete a Record 

1- Open the Data Form dialog box. 

Note: See the previous steps to learn how to open the dialog box. 

2- Click Find Prev or Find Next to navigate to the record you want to remove. 

3- Click Delete. 

A prompt box appears warning about the deletion. 

4- Click OK. 

 

How do I add a new record using the form? 

To add a new record at any time, click New. The Data Form dialog box immediately displays 

a new record, and you can start typing new data into the fields. 

 

Search for Records  

You can use the Data Form to help you display only records matching the criteria you 

specify. For example, if you want to view all the clients from the same city or state, you can 

use the Data Form to search for matching records. 

 

1- Open the Data Form dialog box. 

Note: You can click Form on the Quick Access toolbar to open the form. See the section 

“Add Records Using a Data Form” to learn more about using the Data Form dialog box. 

2- Click Criteria. 

3- Click in the field for which you want to specify search criteria and then type the criteria 

you want to match. 

4- Click Find Prev or Find Next to navigate through the matches. When you finish searching 

through records, click Close to close the form. 

 

Set Data Validation Rules  

You can set up your database table to control exactly what kinds of data are allowed in the 

cells. This is handy if other people use your list to enter records. You can make sure that they 

type the right kind of data in a cell by assigning a data validation rule. If they type the wrong 

data, such as text data instead of numerical data, Excel displays an error box to prompt them 

about what data can be entered into the cell. 

 

1- Select the range to which you want to apply a data validation rule. 

2- Click the Data tab. 

3- Click Data Validation. The Data Validation dialog box opens. 

4- Click the Settings tab. 

5- Click here and then select which type of data you want the cell to allow. 

6- Define the data type parameters, if needed, by clicking the Collapse button. 

7- Click the Error Alert tab. 

8- Type a title for the error message. 

9- Type instructions to help the user remedy the mistake. 

10- Click OK. 

Note: If you or another user type the wrong data in the table‟s cells, an error alert box ppears. 

 

Sort Records  

You can sort your database table to reorganize the information. For example, you might want 

to sort a client table to list the names alphabetically. An ascending sort lists records from A to 

Z, and a descending sort lists records from Z to A. 

 

1- Click in the field name you want to sort. 

2- Click the Data tab. 

3- Click Sort A to Z (↓) or Sort Z to A(↑). 

Excel sorts the records based on the field you specified. 
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Sort with the Sort Dialog Box 

1- Click the Data tab. 

2- Click Sort. The Sort dialog box opens. 

3- Click here and then select the primary field to sort by. 

4- Click whether you want to sort the field in ascending or descending order. 

Note: To specify additional fields for the sort, choose criteria from the Sort on drop-down 

list. 

5- To add additional sort levels, click Add Level and then make settings for the next sort 

level. 

6- Click OK. Excel sorts the data. 

 

Filter Data with AutoFilter 

You can use a filter to view only portions of your data. Unlike a sort, which sorts the entire 

table, a filter selects certain records to display based on your criteria, while hiding the other 

records that do not match the criteria. 

 

1- Select the field labels for the data you want to filter. 

2- Click the Data tab. 

3- Click Filter. 

Note: If you used the Create Table command to create a database table, your table already 

displays the AutoFilter buttons. 

Excel adds a dropdown list to your field labels. 

4- Click the dropdown list. 

5- Click any item you want filtered out. Records that match the checked items remain after 

you apply the filter. 

6- Click OK. 

Excel filters the table and replaces the filter arrow with a filter icon. 

To view all the records again, display the filter list and click Clear Filter from “Field Name.” 

 

In what ways can I customize a filter? 

You can activate the Advanced command on the Data tab to open the Advanced Filter dialog 

box. Here you can further customize the filter by selecting operators and values to apply on 

the filtered data. 

 

Analyze Data with a PivotTable  
You can use PivotTables to gain different perspectives on your data. PivotTables enable you to ask 
certain questions of your data to help you see beyond the obvious. Rather than examining the data for 

answers yourself, a PivotTable helps you to quickly analyze the meaning of sets of data. 

 
For example, say you have a sales order table that describes products, quantities ordered, dates, 

amounts, buyers, and salespersons. You can use a PivotTable to find out which salesperson has the 

most sales, which buyer buys the most product, what items are the top sellers, and who sold the most 
product on a given day. These are just a few analysis points you can find out with PivotTables. 

 

1- Click inside the database list. 

2- Click the Insert tab. 

3- Click PivotTable. The Create Pivot Table dialog box opens. 

4- Click range button to choose the table range. 

5- Select a range and then click. 

6- Click to specify where to place the table. 

7- Click OK. 

 

Can I change any options for my PivotTable? 

On the PivotTable Tools tab, you can click Options to display the PivotTable Options dialog 

box. Here you can modify the layout and format of the PivotTable, decide whether to show 

totals or filter data, and more. 
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How are PivotTables constructed? 

PivotTables are made of row fields and column fields that summarize data across rows and 

fields, respectively. The middle area is where the actual analysis occurs for summarizing 

different fields of data pertaining to the row and column fields. 

 

After you create a PivotTable, you can drag various fields into the table to perform analyses. 

It might take some experimenting to figure out how your data works within the PivotTable. 

As you add and subtract fields and change their position on the table, the data you examine 

“pivots,” hence the name PivotTable. 

 

Note:- Excel opens a new, empty PivotTable and displays the PivotTable Field List. 

8- Click a field you want to analyze 

9- Drag the field box to the Column Label or Row Label area of the PivotTable Field List. 

10- Click another field you want to analyze. Excel adds the field data, which you can then 

analyze. 

 

To remove a field from the table, click the field to deselect it. 

 

2.3.9-Sharing Excel Data (Data Import Export) 
You can share Excel data between worksheets, workbooks, and with other users. 

 

Import Data 

You can transfer data from other sources into your Excel worksheet. For example, you can 

import text files as well as database and Web queries. 

1- Click the Data tab. 

2- Click Get External Data. 

3- Click From Text. The Import Text File dialog box opens. 

4- Navigate to the file you want to import. 

5- Click the filename. 

6- Click Import. Excel imports the data. 

 

Export Data 

You can use the Save As dialog box to export your workbook data by saving the data as 

another file format. For example, you might save your workbook as a text file to send to 

someone who does not use Excel as his or her spreadsheet program. 

1- Click Data export Icon. 

2- Click Save As. The Save As dialog box opens. 

3- Navigate to the folder to which you want to save the file. 

4- Type a filename. 

5- Click the Save as Type and select a file type. 

6- Click Save. Excel saves the data to the new format. 

2.3- MS Excel Practical Exercise 
Problem NO-1  [Preparing Bill] 

 A B C D E 

1 S. No: Particular Quantity Rate Cost 

2 1 TV 20 21000  

3 2 VCD 15 12000  

4 3 Radio 12 5000  

5 4 Cassette player 18 11000  

6  Total  

7  Discount 15%  

8 Total Amount  

9 Vat 10%  

10 Grand Total  
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Solution to Calculate Bill  

To find Cost        =C2*D2 

To find Total =sum (E2:E5)  

To find Discount = E6*0.15 

To find Total Amount =E6-E7 

To find Vat 10% =E8*0.10 

To fiend Grand Total =E8+E9 

 

Problem NO-2  [Preparing Employee Salary Sheet] 

 

Solution to employee prepare salary sheet  

To find Bonus   =Salary* Bonus% 

Example  =E3*75% 

To find provident fund  =Salary*10% 

Example =E3*10% 

To find Net Salary  =Salary +Bonus-P.found 

Example =E3+F3-G3 

 

Problem NO - 3        [Calculating Interest] 

 Interest Sheet  

 A B C D E F G H 

1 S.No Name of 

person 

Capital Time 

(YR) 

Interest 

Rate % 

Interest Total 

Amount t 

 

2 01 Sita  Ram 100000 3 13    

3 02 Hari  250000 2 14    

4 03 Ram 75000 4 13    

5 04 Puja  100000 3 36    

6 05 Krishana  25000 2 20    

 

Soution to calculate interest 

Formula  =Capital*Time*Rate/100 

Example =C2*D2*F2/100 

To find total amount  =Capital + Interest  

Example =C2+F2 

 

Problem: NO – 4  [Preparing Electric Bill] 

Inputs data are Consumer Name, Current Month Reading, Previous Month Reading of 

Electricity consumers. 

Billing rate as listed below: 

Up to 20 unit Rs.85 

21 to 300 units   Rs. 7 pre unite 

Above 300   units  Rs.10 pre unite  

 A B C D E F 

1 Consumer  

Number 

Name Previous 

Month 

Reading 

Current 

Month 

Reading 

Unit 

Consume 

Bill 

Amount 

  A C D E F G H 

1 Salary Sheet of e-Soft Private limited. 

2 S.No Name  Post Address  Salary  Bonus P. Fund Net Salary 

3 01 Krishana Manager Kapan 12000    

4 02 Shyam Pro.coordinator Chabahil 8500    

5 03 Ambika Accountant Baneshower 7800    

6 04 Gita Marketing Kavre 6000    

7 05 Hari Driver Lagnkhel 5000    
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2 1001 Ameet Shrestha  2357 2467   

3 1002 Rjiv Pradha 1345 1858   

4 1003 Kamal Shai 2691 2698   

 

Solution to calculate electric Bill Amount 

To Find Consume Unit             =Current Month Reading –Previous Month Reading 

Example  

To Find Bill Amount =IF(E2<=20,78, IF(E2<=300, (E2-20)*7 + 78, 78 + 280*7 

+ (E2-300)*10)) 

 

Problem NO – 5 [If condition complex analysis] 

Input given is Serial Number Name Education Code (EC) of 6 peoples. Find Remarks 

 EC  Rem 

      1  Master or Above  

      2  Diploma 

      3  Certificate 

      4  SLC 

      5  Literate 

      6  Illiterate 

 

 A B C D E 

1 S.NO: Name Education 

Code 

Remark  

2 1001 Sagun 5   

3 1002 Niraj 3   

4 1003 Anjan 4   

5 1004 Ismit 1   

6 1005 Ishan 2   

7 1006 Ishani 6   

 

Solution to find Remark 

=If(C2=1,"Master or Above", If(C2 =2,"Diploma", If(C2=3,"Certificate", If(C2=4, "SLC", 

If(C2=5, "Literate", "Illirete"))))) 

 

Problem NO – 6  [Preparing Students Result Sheet] 

  A B C D E F G H I J K L 

1 Microsoft College of Information Technology 
2 Bsc CSIT PROGRAM First Semester 2070/2071 

3 End Term Exam Result 2070/2071 

4 

S.N 

Student Name IntroIT 

C 

Prog Math English Prb&Stat Total 

Result Per(%) Div Rank 

5 Full Marks 60 60 80 60 60 320 

6 Pass Marks 24 24 32 24 24 128 

7 Highest Mark             

8 1 Aastha Timalsina 51 28 68 40 56           

9 2 Aruna Shrestha 32 33 30 32 34           

10 3 Babita Thapa 44 24 44 52 49           

11 4 Bijay Prajapati 34 33 54 50 50           

12 5 Bijay Thapa 27 28 37 50 47           

13 6 Bikram Shrestha 35 53 41 40 49           

14 7 Deb Raj Badal 24 24 49 38 39           

15 8 Hemant Raj Singh 40 33 47 44 48           

16 9 Manish Shrestha 33 10 44 42 33           
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17 10 Prabek Rajbanshi 37 30 50 44 41           

18 11 Prabha Thapa 51 50 75 52 57           

19 12 Rojan Manandhar 43 43 72 58 60           

20 13 Sabin K.C. 43 24 62 48 57           

21 14 Sabin Nepal 39 19 42 32 50           

22 15 Sachita Thapa 37 28 52 38 51           

23 16 Suman Humagain 47 44 56 48 58           

24 17 Suraj Deuja 37 31 48 39 51           

25 18 

Sushil Chandra 

Basnet 28 24 53 33 43           

26 19 

Utsana Siku 

Shrestha 54 36 66 55 51           

27 20 Shreesti Kunwar 41 31 63 57 57           

28 Result Analysis 

29 Number of students with Distinction     

30 Number of students with First Division     

31 Number of students with Passed Division     

32 Number of Failed Students     

 

Question to solve 

Q1-Prepare a result sheet 

Q2-Apply appropriate conditional formatting to the cell of result column 

a) Set red color if failed division 

b) Set blue color if passed division 

c) Set yellow color if first division 

d) Set green color if distinction division 

 

Q-3 Perform following calculation 

a) Number of students with Distinction Division. 

b) Number of students with First Division. 

c) Number of students with Passed Division. 

d) Number of Failed Students. 

 

Q-4 Apply auto filter to the result sheet and perform result analysis 

Solution to prepare result sheet 

Total  =SUM (First subject : Last Subject) 

Example =SUM (C8 : G8) 

Result  = IF (AND (C8>=24, D8>=24,E8>=32, F8>=24, G8>=24), "Passed", "Failed") 

Per (%)  = 100*H8/$H$5 

Division =IF (I8=" Failed ","Failed", IF( J8>=80,"Dist", IF(J8>=60,"First", 

"Passed"))) 

Rank  = RANK (J8, J$8:J$27) 

 

Number of students with Distinction Division = COUNTIF (K$8: K$27, "Dist") 

Number of students with First Division =COUNTIF (K$8: K$27, "First") 

Number of students with Passed Division =COUNTIF (K$8: K$27, "Passed") 

Number of Failed Students = COUNTIF (K$8: K$27, "Failed") 

 

Problem NO – 7  [Generating charts for analysis] 

Q1-Generate a pie chart to display following information. 
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Q2- Generate a bar chart to display following information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Problem NO – 8  [Data analysis] 

Order 

ID 

Product 

Name 

Quantity 

Ordered Amount 

Order 

Date 

Customer 

Name 

Sales 

Person 

1 TV LG-14 43 900000 9/5/2015 Mical Tilak 

2 VCR-4009 200 450000 12/6/2015 Raj Tilak 

3 

DVD Plyar 

10 130 240000 12/6/2015 Raj Tilak 

4 Laptop-303 12 600000 11/7/2015 Pranita Janak 

5 

Video 

Camera 55 300000 11/7/2015 Pranita Janak 

6 TV LG-14 12 250000 18/7/2015 Ramesh Tilak 

7 

DVD Plyar 

10 55 105000 11/8/2015 Raj Narayan 

8 TV LG-14 21 450000 11/8/2015 Raj Tilak 

9 

DVD Plyar 

10 23 50000 9/10/2015 Shyam Tilak 

10 

DVD Plyar 

10 40 90000 21/11/2015 Pranita Narayan 
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QN-a- Apply AutoFilter with the table below and perform several analyses. 

QN-b- Create pivot table from the given table and examine PivotTable to perform 

analysis (find out which salesperson has the most sales, which buyer buys the most 

product, what items are the top sellers e.tc).  

 

Problem NO – 9 [Basic Accounting- Preparing Journal and Nominal Ledger] 

This is a comprehensive project. You can form a group of 3-4 people and gather annual 

records of accounting data of a company and perform following activities in excel 

program. 

a) You are asked to prepare a journal entry of an account in an excel workbook. 

b) You are also asked to prepare nominal ledger in a separate workbook. 

 

Note: - The Journal is a textual record of events (Debit and Credit) that is characterized by 

the fact that all the records it contains are in a sequential chronological order. The Nominal 

ledger Is made up of separate accounts for each matter (cash, banks, customers and so forth). 

 

c) You are asked to prepare a trail balance of the nominal ledger in an excel sheet. 

 

Note: - After transferring the records to the Journal (Journal Entries) and from there to the 

account in the Nominal Ledger, the balance for each account is found organizing all the 

transactions and balance in every account in the nominal ledger into a table. This 

arrangement is called the Trial Balance. In the Trial Balance (balances), the "Total Debit 

Balances" column must be identical to the "Total Credit Balances" column. 

 

d) You are further asked to prepare a profit loss statement for the year ending 

Ashad 2072 & balance sheet for the year ending Ashad 2072 based on the data of 

trail balance that you have already prepared. 

 

Note: - At the end of each year, the bookkeeping system produces two statements (directly 

from the Trial Balance). They are a) profit loss statement & b) balance sheet. The Balance 

Sheet is in fact made up of two parts while: The total assets of the business (the debit side) 

= The total obligations to external agencies (the credit side) + the total obligations to the 

owner of the business. 

 

Accounting Equation is a mathematical expression of the relationship of property and 

property rights that is also called the Balance Sheet Equation.  

 

The equation may be expressed in three forms:  

Assets = Liabilities + Owner's Equity (Capital)  

OR 

Assets = Liabilities + Beginning Owner's Equity (Capital) + Additional Owner Investments  

+ Revenues - Expenses - Draws  
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Unit 3: Introduction to MIS   [LH 5 Hrs] 
3.1-What is an Information System (IS)? 
An Information System is a set of interrelated components that collect, analyze and 

disseminate data and information to support decision making coordination, and control to an 

organization. 

 

Information systems contain information about significant people, places, and things within 

the organization or in the environment surrounding it. Data is streams of raw facts 

representing events occurring in organization or the physical environment before they have 

been organized and arranged into a form that people can understand and use. 

 

Three major activities in an information system are input, processing, and output. Input is 

the capture or collection of raw data from within the organization or from its external 

environment for processing in an information system. Processing is the conversion, 

manipulation, and analysis of raw input into a form that is more meaningful to humans. 

Output is the distribution of processed information to the people who will use it or to the 

activities for which it will be used. Information systems also require feedback, which is 

output that is returned to the appropriate members of the organization to help them evaluate 

or correct input. 

 

In fact, Information Systems (IS) are pervasive, versatile, and instrumental in helping 

organizations achieve their strategic, tactical, and operational goals.  

 

3.2-Components of an Information Systems 
 Hardware, computer equipment used for 

→ input 

→ processing 

→ outputs 

 Software, computer programs that run on hardware: 

→ systems software 

→ applications software 

 Databases: specialized applications software designed to organize data and information 

on an organization‟s operations 

 Infrastructure: equipment designed to link hardware across space: 

→ telecommunications 

→ networks 

→ Internet 

 People: IS personnel and users 

 Procedures: rules for developing and using the IS 

 

Formal IS can be either computer-based or manual systems use paper-and pencil technology. 

Computer-based systems, in contrast, relay on computer hardware and software technology to 

process and disseminate information. Although computer-based information systems use 

computer technology to process raw data into meaningful information, there is a sharp 

distinction between a computer and a computer program on one hand, and an information 

system on the other. Electronic computers and related software programs are the technical 

foundation, the tools and materials, of modern information systems. Computers provide the 

equipment for storing and processing information. Computer programs are sets of operating 

instructions that direct and control computer processing. Computers are only part of an 

information system. 
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3.3-Information Technology vs. Information System 
Information system 

 A system that creates, processes, stores, and retrieves information. 

 The input to such a system is data: processed data becomes information. 

 

Information technologies 

 Tools and techniques that support the design and development of information systems: 

these include hardware, software, database, telecommunications, and client servers. 

Information systems use Information Technology as tools for the storing and rapid processing 

of information leading to analysis, decision-making and better coordination and control. 

Hence information technology forms the basis of any modern information systems.  

 

3.4-General Classification of Information Systems  
Several categories of information systems can support either operations or management 

applications. For example, expert systems can provide expert advice for operational chores 

like equipment diagnostics or managerial-based information systems that support the 

creation, organization, and dissemination of business knowledge to employees and managers 

throughout a company. 

 

Figure3.1 Major Types of System 
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Other Classifications of Information Systems 

 

3.4.1-Transaction Processing Systems (TPS) 

 

Figure3.2Transaction Processing System 

 

Transaction processing is a style 

of computing that divides work 

into indivisible operations, called 

transactions. Transaction 

Processing Systems (TPS) are 

the basic business systems that 

serve the operational level of the 

organization. A transaction 

processing system is a 

computerized system that 

performs and records the daily 

routine transactions necessary to 

conduct the business.  

 

3.4.2-Knowledge Work and Office Systems 

Knowledge Work System (KWS) and office systems serve the information needs at the 

knowledge level of the organization. Knowledge workers are people who hold formal 

university degree and who are often members of a recognized profession, such as engineers, 

doctors, lawyers, and scientists. Data workers typically have less formal, advanced 

educational degrees and tend to process rather than create information.  

 

Word processing refer to office system technology that facilitates that creation of documents 

through computerized text editing, formatting, storing, and printing. Desktop publishing 

refers to technology that produces professional-quality document combining output from 

word processors with design, graphics, and special layout features. Document imaging 

systems refer system that converts documents and images into digital form so that they can 

be stored and accessed by the computer. 

 

Requirements of Knowledge Work Systems 

Knowledge work systems have characteristics that reflect the special needs of knowledge 

workers. First, knowledge work systems must give knowledge workers the specialized tools 

they need, such as powerful graphics, analytical tools, and communications and document 
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management tools. These systems require great computing power to handle the sophisticated 

graphics or complex calculations necessary for such knowledge workers as scientific 

researchers, product designers, and financial analysts. Because knowledge workers are so 

focused on knowledge in the external world, these systems also must give the worker quick 

and easy access to external databases.  

A user-friendly interface is very important to a knowledge worker‟s system. User-friendly 

interfaces save time by enabling the user to perform needed tasks and get to required 

information without having to spend a lot of time learning how to use the computer. Saving 

time is more important for knowledge workers than for most other employees because 

knowledge workers are highly paid. 

 

3.4.3-Management Information Systems 

Introduction 

Management Information Systems (MIS) refer information systems at the management level 

of an organization that serve the functions of planning, controlling, and decision making by 

providing routine summary and exception reports. A management information system 

(MIS) provides information needed to manage organizations efficiently and effectively.  

In a management information system, modern, computerized systems continuously gather 

relevant data, both from inside and outside an organization. This data is then processed, 

integrated, and stored in a centralized database (or data warehouse) where it is constantly 

updated and made available to all who have the authority to access it, in a form that suits their 

purpose. Management information systems (MIS) serve the management level of 

organization, providing managers with reports and, in some cases, with online access to the 

organization‟s current performance and historical records. Typically, they are oriented almost 

exclusively to internal, not environmental or external, events. Generally, they depend on 

underlying transaction-processing system for their data. MIS summarize and report on the 

company‟s basic operations.  

 

Figure3.3Management Information Systems 

Transaction Processing Systems  Management Information Systems 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Importance and benefits of MIS 

At the present, organizations realize that information is important as a property. It can add 

value to organizations. As well as, it helps organizations to survive among intensive 

competition. Therefore, organizations need information for management. The overall purpose 

of MIS is to provide profitability and related information to help managers and staffs 

understand business performance and plan its future direction.  

 MIS is always management oriented and keeps in view every level of management and 

gets the desired information.  

Order 

processing 

system 

Materials 

resource 

planning 

system 

General 

ledger 

system 

Order 

file 

Production 

master file 

Accountin

g file 

Sales 

data 

Unit 

Product 

cost data 

Product 

change 

data 

Expense 

data 

MIS FILES 

MIS Reports Managers 



48 

 Integrated - refers to how diff components (sub systems) are actually tied up together. 

Example: diff departments of organization linked together.  

 Useful for planning - as every organization makes log-term and short-term plans with the 

help of information like sales & production, capital investments, stocks etc. management 

can easily plan. 

 Effective MIS helps the management to know deviations of actual performance from pre-

set targets and control things.  

 Its‟ important for increasing efficiency.  

 MIS provides updated results of various departments to management.  

 MIS is highly computerized so it provides accurate results.  

 MIS adds to the intelligence, alertness, awareness of managers by providing them 

information in the form of progress and review reports of an ongoing activity.  

 Helps managers in decision- making. 

 Good MIS will show how an operation accords to an organization goal. It‟s adopted to 

monitor an operation. 

 MIS reduce organizations‟ cost because of time, labor and expenses reducing in long run. 

 

Problems with MIS 

There is abundant evidence from numerous surveys conducted in developed countries, 

particularly in the UK and USA, that existing MIS, often using advanced computer 

equipment, have had relatively little success in providing management with the information it 

needs. Reasons discovered include the following: 

 Lack of management involvement with the design of the MIS; 

 Narrow or inappropriate emphasis of the computer system; 

 Undue concentration on low-level data processing applications particularly in the 

accounting area; 

 Poor appreciation by information specialists of management‟s true information 

requirements and of organizational problems; and 

 Lack of top management support. 

 

To be successful, an MIS must be designed and operated with due regard to organizational 

and behavioral principles as well as technical factors. Management must be informed enough 

to make an effective contribution to system design, and information specialists (including 

systems analysts, accountants and operations researchers) must become more aware of 

managerial functions and needs so that, jointly, more effective MIS are developed. 

Management do not always know what information they need and information professionals 

often do not know enough about management in order to produce relevant information for the 

managers they serve. There is no doubt that better communication between management and 

information professionals and a wider knowledge by both groups of MIS principles would 

greatly facilitate the task of developing relevant and appropriate information systems. 

 

3.4.4- Decision-Support Systems 

Decision-Support Systems (DSS) also serve the management level of the organization. DSS 

help managers make decisions that are unique, rapidly changing, not easily specified in 

advance. They address problems where the procedure for arriving at a solution may not be 

fully predefined in advance. 

Decision-support systems (DSS) support more non-routine decision making. They focus on 

problems that are unique and rapidly changing, for which the procedure for arriving at a 

solution may not be fully predefined in advance. 

 

3.4.5- Executive Support Systems 

ESS serves the strategic level of the organization. Executive support systems (ESS) help 

senior management make these decisions. They address non-routine decisions requiring 

judgment, evaluation, and insight because there is no agreed-on procedure for arriving at a 

solution. ESS present graphs and data from many sources through an interface that is easy for 
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senior managers to use. Often the information is delivered to senior executives through a 

portal, which uses a Web interface to present integrated personalized business content. 

ESS is designed to incorporate data about external events, such as new tax laws or 

competitors, but they also draw summarized information from internal MIS and DSS. They 

filter, compress, and track critical data, displaying the data of greatest importance to senior 

managers. Increasingly, such systems include business intelligence analytics for analyzing 

trends, forecasting, and “drilling down” to data at greater levels of detail. 

 

3.6-Decision Support Systems 
3.6.1-Introduction 

Decision Making is the process of developing and analyzing alternatives to make a decision - 

a choice from the available alternatives. Most decisions are made in response to a problem - a 

discrepancy between a desirable and an actual decision and involve judgment - the cognitive 

aspects of the decision-making process. Decisions can be classified as either programmed or 

non-programmed. 

Business Decision Making is closely related to, and has its origin, in the field of 

management science, also called operation research. Management Science is the scientific 

approach to decision making that often uses mathematical models. Operation Management is 

atypical branch of management science that combines theory and practice emphasizing 

quantitative and statistical models or approaches for decision making, with the use of 

computer. 

 

A decision support system (DSS) is a computer-based information system that supports 

business or organizational decision-making activities. DSSs serve the management, 

operations, and planning levels of an organization and help to make decisions, which may be 

rapidly changing and not easily specified in advance. 

Typical information that a decision support application might gather and present would be: 

 Accessing all of your current information assets, including legacy and relational data 

sources, cubes, data warehouses, and data marts. 

 Comparative sales figures between one week and the next 

 Projected revenue figures based on new product sales assumptions 

 The consequences of different decision alternatives, given past experience in a context 

that is described 

A decision support system may present information graphically and may include an expert 

system or artificial intelligence (AI). It may be aimed at business executives or some other 

group of knowledge workers. 

 

Some Examples of DSS Applications in Business 

 Forecasting 

o What will be customer demand in next few weeks/months/years? 

o What will be most likely sales figure in future? 

 Scheduling and planning 

o What job do we perform next? 

o What is the job process to minimize the processing time and maximize the 

contribution time from the labor? 

o How to minimize the waste of resources and maximize the production? 

 Inventory management 

o How much inventory should we have? 

o How much to order and when to order? 

 Supply chain management 

o Which vendor should we select? 

o Should we in or outsource our product /services? 

o How to distribute the product/services to customers? 
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3.5-Importance of Information System 
Information is a critical resource in the operation and management of organizations. Timely 

availability of relevant information is vital for effective performance of managerial functions 

such as planning, organizing, leading, and control. An information system in an organization 

is like the nervous system in the human body, it is the link that connects all the organization's 

components together and provides for better operation and survival in a competitive 

environment. The system ensures that an appropriate data is collected from the various 

sources, processed, and sent further to all the needy destinations. The system is expected to 

fulfill the information needs of an individual, a group of individuals, the management 

functionaries: the managers and the top management. The IS plays the role of information 

generation, communication, problem identification and helps in the process of decision 

making. The IS, therefore, plays a vital role in the management, administration and 

operations of an organization. Indeed, today's organizations run on information. 

 

 Support of Business Process and Operations: Retail stores use computer-based IS to 

help their employees record customer, keep track of inventory, pay employees, buy new 

merchandise, and evaluate sales trends. The IS helps the clerical personnel in the 

transaction processing and answers their queries on the data pertaining to the transaction, 

the status of a particular record and references on a variety of documents. 

 Support of Business Decision Making: Managers and other business professional use IS 

for better decisions. For example, decisions about what lines of merchandise need to be 

added or discontinued and what kind of investments they require are typically made after 

an analysis provided by computer-based information systems. The MIS (special category 

of IS) helps the middle management in short them planning, target setting and controlling 

the business functions. It is supported by the use of the management tools of planning and 

control. 

 Support of Strategies for Competitive Advantage: Gaining a strategic advantage over 

competitors requires the innovative application of IT. For example, store management 

might make a decision to install touch-screen kiosk in all stores, with link to the e-

commerce Web site for online shopping and buying products provided by such 

information system. This offering might attract new customers and build customer 

loyalty. 

 

3.6-Understanding the Business values of Information system 
Information has a great impact on decision making, and hence its value is closely tied to the 

decisions that result from its use. Information does not have an absolute universal value. Its 

value is related to those who use it, when it is used, and in what situation it is used. In this 

sense, information is similar to other commodities. For example, the value of a glass of water 

is different for someone who has lost his way in Arctic glaciers than it is to a wanderer in the 

Sahara Desert.  

 

Economists distinguish value from cost or price of a commodity incurred to produce or 

procure the commodity. Obviously, the value of a product must be higher than its cost or 

price for it to be cost-effective.  

 

Information supports decisions, decisions trigger actions, and actions affect the achievements 

or performance of the organization. If we can measure the differences in performance, we can 

trace the impact of information, provided that the measurements are carefully performed, the 

relationships among variables are well defined, and possible effects of irrelevant factors are 

isolated. The measured difference in performance due to informational factors is called the 

realistic value or revealed value of information.  

 

3.7-Information system success and failure 
Benefits from information technology investments will be reduced if firms do not consider 

the costs of organizational change associated with a new system or make these changes 
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effectively. The alternation of an information system has a powerful behavioral impact. A 

very large percentage of information systems fail to deliver benefits or to solve the problems 

for which they were intended because the process of organizational change surrounding 

system building was not properly addressed. Successful system building requires careful 

change management. 

The major problem areas causing information system failure are information systems‟ design, 

data, cost, and operations. 

 

Design: The actual design of the system may fail to capture essential business requirements 

or improve organizational performance. Information may not be provided quickly enough to 

be helpful; it may be in a format that is impossible to digest and use; or it may represent the 

wrong pieces of data. 

The way in which nontechnical business users must interact with the system may be 

excessively complicated and discouraging. A system may be designed with a poor user 

interface. The user interface is the part of system with which the end users interact. For 

example an input form or an online data entry screen may be so poorly arranged then no one 

wants to submit data. The procedures to request online information retrieval may be so 

unintelligible that users are too frustrated to make requests. 

An information system will be judged a failure if its design is not compatible with the 

structure, culture, and goals of the organization as a whole. 

 

Data: The data in a system may have a high level of inaccuracy or inconsistency. The 

information in certain field may be erroneous, or it may not be organized properly for 

business purposes. Information required for a specific business function may be inaccessible 

because the data are incomplete. 

Cost: Some systems operate quite smoothly, but their cost to implement and run on a 

production basis may be way over budget. Other system projects may be too costly to 

complete. 

Operations: Sometimes system does not run well if there is no technically sound person to 

operate the system. If information is not provided in a timely and efficient manner, 

information is processing break down and lead to excessive delayed or missed schedules for 

delivery of information.  

Some of these problems can be attributed to technical features of information systems. 

System builders need to understand these organizational issues and learn how to manage the 

change associated with the new information system. 

 

3.8-Overview of the System Implementation Process 
Steps for Implementing New Systems 

Acquisition:- Evaluate and acquire necessary hardware and software resources and 

information system services. 

Software Development:- Develop any software that will not be acquired externally as 

software packages. Make any necessary modifications to software packages that are acquired. 

Data Conversion:- Convert data in company database to new data formats and subsets 

required by newly installed software. 

Training:- Educate and train management, end users, customers and other business 

stakeholders. Use consultants or training programs to develop user competencies. 

Testing:- Test and make necessary corrections to the programs, procedures and hardware 

used by a new system. 

Documentation:- Record and communicate detailed system specifications, including 

procedures for end users and IS personal and experts of input screen and output displays and 

reports. 

Conversion:- Convert from the use of a present system to the operations of a new system. 

This may include operating both new and old system in parallel for a trail period. 
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3.9-Implementing System Conversion Strategies 
Conversion is the process of changing from the old system to the new system. Four main 

forms of system conversion strategies can be employed:  

1. Parallel conversion 

2. Phased conversion 

3. Pilot conversion 

4. Direct conversion 

 

The direct cutover strategy replaces the old system entirely with the new system on an 

appointed day. It is very risky approach that can potentially be more costly than parallel 

activities if serious problem with the new system is found. 

 

In a parallel strategy both the old system and its potential replacement are run together for a 

time until everyone is assured that the new one functions correctly. This is safer safest 

conversion approach; however this approach is very expensive. To execute parallel approach 

properly, the end users must literally perform all daily functions with both systems, thus 

creating a massive redundancy in activities and literally double the work. 

 

The phased approach strategy introduces the new system in stages, either by functions or by 

organizational units. Phased conversion is analogous to the release of multiple versions of an 

application by software developer. Although it has advantage of the lower risk, the phase 

approach takes the most time. 

 

The pilot study strategy introduces the new system to only a limited area of the organization, 

such as a single department or operating unit. When this pilot version is complete and 

working smoothly, it is installed throughout the rest of the organization. 

 

3.10-MIS Summery 
Management information systems (MIS) provide information in the form of reports and displays to 

support business decision making for managers and many business professionals. For example, sales 

managers may use their networked computers and Web browsers to receive instantaneous displays 
about the sales results of their products and access their corporate intranet for daily sales analysis 

reports that evaluate sales made by each salesperson. 

Decision support systems (DSS) give interactive ad hoc computer support to managers during the 
decision-making process. For example, an advertising manager may use a DSS to perform a what-if 

analysis as part of the decision to determine how to spend advertising dollars. A production manager 

may use a DSS to decide how much product to manufacture, based on the expected sales associated 
with a future promotion and the location and availability of the raw materials necessary to 

manufacture the product. 

Executive information systems (EIS) provide critical information from a wide variety of internal and 

external sources in easy-to-use displays to executives and managers. For example, top executives may 
use touch-screen terminals to view instantly text and graphics displays that highlight key areas to 

analyze competitive performance, actions of competitors, and economic developments to support 

strategic planning. 
Expert systems are knowledge-based systems that provide expert advice and act as expert consultants 

to users. Examples: credit application advisor, process monitor, and diagnostic maintenance systems. 

Knowledge management systems support the creation, organization, and dissemination of business 

knowledge within the enterprise. Examples: intranet access to best business practices, sales proposal 
strategies, and customer problem resolution systems. 

Strategic information systems support operations or management processes that provide a firm with 

strategic products, services, and capabilities for competitive advantage. Examples: online stock 
trading, shipment tracking, and e-commerce Web systems. 

Functional business systems support a variety of operational and managerial applications of the 

basic business functions of a company. Examples: information systems that support applications in 
accounting, finance, marketing, operations management, and human resource management. 
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Unit 4: Enterprise Resource Planning [LH 5hrs] 

4.1-E-Business & e-Commerce 
The Internet and related technologies and applications have changed the ways businesses 

operate and people work, as well as how information systems support business processes, 

decision making, and competitive advantage. Thus, many businesses today are using Internet 

technologies to Web-enable their business processes and create innovative e-business 

applications.  

 

‘Electronic business, or e-business, refers to the use of digital technology and the Internet to 

execute the major business processes in the enterprise. E-business includes activities for the 

internal management of the firm and for coordination with suppliers and other business 

partners. It also includes electronic commerce, or e-commerce. E-Business (electronic 

business) uses information and communication technologies technology to improve overall 

business processes. This includes managing internal processes such as human resources, 

financial and administration systems, as well as external processes such as sales and 

marketing, supply of goods and services, and customer relationships. 

 

E-commerce is the part of e-business that deals with the buying and selling of goods and 

services over the Internet. It also encompasses activities supporting those market transactions, 

such as advertising, marketing, customer support, security, delivery, and payment. 

 

E-business is the use of Internet technologies to work and empower business processes, e-

commerce, and enterprise collaboration within a company and with its customers, suppliers, 

and other business stakeholders. E-business’ is brooder term referring to how technology 

can benefit all internal business process and interactions with third parties. 

 

Electronic commerce commonly written as e-commerce, refers to buying, selling, marketing, 

and servicing of products, services, and information over a variety of computer networks. 

Electronic commerce draws on technologies such as mobile commerce, electronic funds 

transfer, supply chain management, Internet marketing, online transaction processing, 

electronic data interchange (EDI), inventory management systems, and automated data 

collection systems. 

 

Many businesses now use the Internet, intranets, extranets, and other networks to support 

every step of the commercial process, including everything from advertising, sales, and 

customer support on the World Wide Web to Internet security and payment mechanisms that 

ensure completion of delivery and payment processes. For example, e-commerce systems 

include Internet Web sites for online sales, extranet access to inventory databases by large 

customers, and the use of corporate intranets by sales reps to access customer records for 

customer relationship management. 

 

4.2-What is business process automation? 
Business process automation (BPA) is the technology-enabled automation of activities or 

services that accomplish a specific function or workflow to reduce costs, resources and 

investment. BPA increases productivity by automating key business processes through 

computing technology. Business processes can be determined for many different segments of 

company activities, including sales, management, operations, supply chain, human resources 

and information technology. 

 

BPA is designed to maintain efficiency and increase the stability and operational productivity 

of an underutilized workforce by integrating business critical software applications. Business 

process automation comes in many forms, from literal assembly lines in the auto industry to 

self-service gas station pumps.  

https://en.wikipedia.org/wiki/Electronic_funds_transfer
https://en.wikipedia.org/wiki/Electronic_funds_transfer
https://en.wikipedia.org/wiki/Electronic_funds_transfer
https://en.wikipedia.org/wiki/Inventory_management_software
https://en.wikipedia.org/wiki/Data_collection
https://en.wikipedia.org/wiki/Data_collection
https://en.wikipedia.org/wiki/Data_collection
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Automation aims to make the entire business process more cost-efficient, streamlined, error-

proof and accessible.  The goal of BPA is to not only automate business processes, but to 

simplify and improve business workflows to improve an organization‟s overall workflow in 

terms of achieving greater efficiency, adapting to changing business needs, reducing human 

error and clarifying job roles and responsibilities. 

The BPA process is geared toward implementing software applications to automate routine 

business tasks through initiation, execution and completion, while achieving enterprise-wide 

workflow efficiency. An Enterprise Resource Planning (ERP) system is often conceived as a 

BPA implementation outcome.  

.  

4.3-Cross-Functional Enterprise Applications 
Many companies today are using information technology to develop integrated cross-

functional enterprise systems that cross the boundaries of traditional business functions in 

order to reengineer and improve vital business processes all across the enterprise. These 

organizations view cross-functional enterprise systems as a strategic way to use IT to share 

information resources and improve the efficiency and effectiveness of business processes, 

and develop strategic relationships with customers, suppliers, and business partners. See 

Figure 4.1, which illustrates a cross-functional business process. 

 

Figure 4.1 presents an enterprise application architecture, which illustrates the 

interrelationships of the major cross-functional enterprise applications that many companies 

have or are installing today. This architecture does not provide a detailed or exhaustive 

application blueprint, but it provides a conceptual framework to help you visualize the basic 

components, processes, and interfaces of these major e-business applications, and their 

interrelationships to each other. This application architecture also spotlights the roles these 

business systems play in supporting the customers, suppliers, partners, and employees of a 

business. 

 

FIGURE 4.1 This enterprise application architecture presents an overview of the major 

cross-functional enterprise applications and their interrelationships. 
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Notice that instead of concentrating on traditional business functions or supporting only the 

internal business processes of a company, enterprise applications focus on accomplishing 

fundamental business processes in concert with a company‟s customer, supplier, partner, and 

employee stakeholders. Thus, enterprise resource planning (ERP) concentrates on the 

efficiency of a firm‟s internal production, distribution, and financial processes. Customer 

relationship management (CRM) focuses on acquiring and retaining profitable customers via 

marketing, sales, and service processes. Partner relationship management (PRM) aims to 

acquire and retain partners who can enhance the sale and distribution of a firm‟s products and 

services. Supply chain management (SCM) focuses on developing the most efficient and 

effective sourcing and procurement processes with suppliers for the products and services 

that a business needs. Knowledge management (KM) applications provide a firm‟s 

employees with tools that support group collaboration and decision support. 

 

4.4-ERP Systems 
To integrate all aspects of a business' operation into one easy-to-use system, many companies 

turn to Enterprise Resource Planning (ERP) solutions. Enterprise systems, also known as 

enterprise resource planning (ERP) systems provide an organization with integrated software 

modules and a unified database which enable efficient planning, managing, and controlling of 

all core business processes across multiple locations. Modules of ERP systems may include 

finance, accounting, marketing, human resources, production, inventory management and 

distribution. ERP solutions store that information in one database, giving businesses a 

simplified look at how all their systems are running.  

 

ERP serves as a cross-functional enterprise backbone that integrates and automates many 

internal business processes and information systems within the manufacturing, logistics, 

distribution, accounting, finance, and human resource functions of a company. ERP also 

served as the vital software engine needed to integrate and accomplish the crossfunctional 

processes that resulted. Now, ERP is recognized as a necessary ingredient that many 

companies need in order to gain the efficiency, agility, and responsiveness required to 

succeed in today‟s dynamic business environment.  

 

FIGURE 4.2 ERP & Enterprise Business Process 

 
 

What ERP can do? 

 ERP automates the tasks necessary to perform a business process such as order 

fulfillment, which involves taking an order from a customer, shipping it and billing 

for it 

 Shares common data bases and business practices 

 Produces information in real time 
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The major application components of ERP systems are grouped together as ERP 

modules which include: 

a) Manufacturing and production systems  

b) Supply chain management (SCM) systems 

c) Customer relationship management (CRM) systems 

d) Financing and accounting system 

e) Human resource management systems 

f) Knowledge management system (KMS) 

 

ERP can be highly customized to meet specific business requirements. ERP systems can 

be integrated with: 

 Warehouse management 

 Logistics 

 Electronic catalogs 

  Quality management system (QMS) 

 Project management system (PMS) 

 

Manufacturing and production systems enable scheduling, assembling product, purchasing, 

shipping, receiving, checking quality, engineering and operations of the production process. 

The major application systems are: material resource planning systems, purchase order 

control systems, engineering systems and quality control systems. 

 

Supply chain management (SCM) systems enable more efficient management of the supply 

chain by integrating the links in a supply chain. This may include suppliers, manufacturer, 

wholesalers, retailers and final customers. 

So supply chain management is a cross-functional enterprise system that uses information 

technology to help support and manage the links between some of a company‟s key business 

processes and those of its suppliers, customers, and business partners. The goal of SCM is to 

create a fast, efficient, and low-cost network of business relationships, or supply chain, to get 

a company‟s products from concept to market. 

 

Customer relationship management (CRM) systems help businesses manage relationships 

with potential and current customers and business partners across marketing, sales, and 

service.  

CRM software helps sales, marketing, and service professionals capture and track relevant 

data about every past and planned contact with prospects and customers, as well as other 

business and life cycle events of customers. Information is captured from all customer touch 

points, such as telephone, fax, e-mail, the company‟s Web site, retail stores, kiosks, and 

personal contact. CRM systems store the data in a common customer database that integrates 

all customer account information and makes it available throughout the company via Internet, 

intranet, or other network links for sales, marketing, service, and other CRM applications. 

 

Financing and accounting system enables budgeting, cost accounting, general ledger, billing 

and fund management. Accounting information systems record and report business 

transactions and other economic events.  

Computer-based accounting systems record and report the flow of funds through an 

organization on a historical basis and produce important financial statements such as balance 

sheets and income statements. Such systems also produce forecasts of future conditions such 

as projected financial statements and financial budgets. A firm‟s financial performance is 

measured against such forecasts by other analytical accounting reports. 

 

Human resource management systems help organization to store information about personal 

records, benefits, compensation, labor relations and trainings. The human resource 

management (HRM) function involves the recruitment, placement, evaluation, 
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compensation, and development of the employees of an organization. The goal of human 

resource management is the effective and efficient use of the human resources of a company. 

 

Knowledge management system (KMS) helps organizations facilitate the collection, 

recording, organization, retrieval, and dissemination of knowledge. This may include 

documents, accounting records, and unrecorded procedures, practices and skills. 

 

ERP systems track business resources (such as cash, raw materials, and production capacity), 

and the status of commitments made by the business (such as customer orders, purchase 

orders, and employee payroll), no matter which department (manufacturing, purchasing, 

sales, accounting, and so on) has entered the data into the system. ERP software suites 

typically consist of integrated modules of manufacturing, distribution, sales, accounting, and 

human resource applications. Examples of manufacturing processes supported are material 

requirements planning, production planning, and capacity planning. Some of the sales and 

marketing processes supported by ERP are sales analysis, sales planning, and pricing 

analysis, while typical distribution applications include order management, purchasing, and 

logistics planning. ERP systems support many vital human resource processes, from 

personnel requirements planning to salary and benefits administration, and accomplish most 

required financial recordkeeping and managerial accounting applications.  

The leader in ERP market share, and the one that invented the market to an extent, is the 

German company SAP AG with its R/3 software. Other big players include PeopleSoft Inc., 

Oracle Corp., Baan Co. NV and J.D. Edwards & Co. 

 

The major ERP software companies have developed modular, Web-enabled software suites 

that integrate ERP, customer relationship management, supply chain management, 

procurement, decision support, enterprise portals, health care functionality, and other 

business applications and functions. Examples include Oracle‟s e-Business Suite and SAP‟s 

mySAP. Some e-business suites disassemble ERP components and integrate them into other 

modules, while other products keep ERP as a distinct module in the software suite. Of course, 

the goal of these software suites is to enable companies to run most of their business 

processes using one Web-enabled system of integrated software and databases, instead of a 

variety of separate e-business applications.  
 
 
 
 
 
 
 
 

FIGURE 4.3 Market 

shares of top five ERP 

vendors 

 

 

 

 

ERP systems attempt to integrate several data sources and processes of an organization into a 

unified system. A typical ERP system will use multiple components of computer software 

and hardware to achieve the integration. A key ingredient of most ERP systems is the use of a 

unified database to store data for the various system modules. The two key components of an 

ERP system are a common database and a modular software design. A common database is 

the system that allows every department of a company to store and retrieve information in 

real-time. Using a common database allows information to be more reliable, accessible, and 

easily shared. Furthermore, a modular software design is a variety of programs that can be 
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added on an individual basis to improve the efficiency of the business. This improves the 

business by adding functionality, mixing and matching programs from different vendors, and 

allowing the company to choose which modules to implement. These modular software 

designs link into the common database, so that all of the information between the 

departments is accessible in real time. 

4.5-Advantage and Disadvantage of ERP System 
4.5.1-Benefits of ERP software 
One of the largest benefits is the picture it gives business owners of their operation. By tying 

critical data from all parts of a company into one easy-to-understand database, business 

owners are able to quickly identify areas of strength, as well as spot looming problems before 

they reach a critical stage. When used properly, the software should provide a better map for 

future planning. 

The software helps businesses cut back on duplication and saves time by better aligning each 

department. This allows for improved workflow and better efficiency, which can boost the 

company's bottom line. 

ERP software is also advantageous for businesses trying to improve their financial reporting 

and regulation compliance. 

 

Advantages: 
1. Better organizational control, especially in large companies, where the volume of 

information is more than in a small company. 

2. Increased customer responsiveness. 

3. Duplication of information is avoided. 

4. Increases communication and collaboration between business unites and sites. 

5. Company can incorporate improved best processes. 

6. Company profitability analysis can be carried out to analyse where costs are higher 

and where there are more sales. 

7. Increases decision-making capabilities within the company. 

8. The company is able to react better to any unforeseen problem or situation. 

9. Better use of time. 

10. May provide a strategic advantage 

 

4.5.2-Drawbacks of ERP software 
The biggest downside to implementing an ERP software solution is the cost. Depending on 

the size of the company, it can cost millions of dollars to install and train employees to use 

the system.  The cost can't just be looked at in terms of purchase price, since it will take a 

considerable effort to train employees how to use the ERP software and how to make sure 

managers are looking at the data properly to ensure they're getting the most out of it. 

 

Since the training can be so extensive, businesses that install the software sometimes 

experience a drop in productivity while employees get brought up to speed. For some, a dip 

in output isn't very noteworthy, but for others, any decline in productivity can be devastating. 

Other expenses include IT infrastructure upgrades that usually need to occur before the 

software is installed, as well as the cost of maintaining the software and making sure it is 

running at optimum performance. 

 

Disadvantages: 

1. The high cost of implementation and maintenance. (High initial investment) 

2. Implementation may require major changes in the company and its processes. 

3. It is so complex that may companies cannot adjust to it. 

4. It is necessary to train all employees in the company so that the system is used 

efficiently.  This is a cost for the company as well as the time and effort needed for it. 

5. Integration with other applications in the enterprise needed. 

6. Inflexibility of the system, because this is a generic system. 
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7. There are few experts in this system. 

8. If the system is not applied correctly, it can be very detrimental to the company. 

4.6-Summery 
 Recap- ERP is a customized computer software application that integrates all departments 

and functions across a company by the creation of a single software program that runs off 

one database 

 Benefits- accurate/ up to date information, decreased errors, improve customer 

satisfaction. 

 Key players- Oracle, Bann, Edwards & Co, People Soft, SAP 

 Targeted to all business but mostly geared towards mid-large size companies 

 Focus in financial, HR, manufacturing industries 

 Every company hires a consultant to address the appropriate ERP software needed to give 

the company a competitive advantage 

 The software is customized to each individual companies needs 

 

Implementing ERP system 

 Holistic approach to implementation 

 Need re-engineer existing business processes to fit processes embedded in software 

 Increasing use of web-enablement to support global availability of some applications: 

Supply chain, customer self-help and self-service, e-commerce applications, Internet 

marketing systems, sales force automation technologies 

  

Discussion Questions 

1. Based on the cost and time consumption of implementing ERP, do you think that 

small companies can truly adopt an ERP system and benefit from it? 

2. What do you think some of the reasons for companies using and ERP system? 

3. Within the future what other types of industries do you see ERP being geared 

towards? 

 

Ans1) Due to a global marketplace, many small companies are merging with larger 

companies in order to survive and gain a competitive advantage. Therefore it is highly 

unlikely that a small firm will spend $15 million on an ERP system, there revenue is just not 

large enough to support this large of an investment. 

 

Ans2)  

 Increase customer responsiveness 

 Global enterprise wide information 

 Enhance organizations and systems flexibility 

 Increase decision making capabilities 

 Increase profitability 

 Decrease productive time to market 

 Streamline financial transaction processing 

 Improve decision-making 

 

Ans3) All Industries 
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Unit 5: Computerized Accounting [LH 5hrs] 

5.1-Introduction to Accounting Software Packages 
All financial application and accounting software offer features such as accounts receivable, 

accounts payable, general ledger, billing and a variety of other standard features, covering a 

vast array of functions and services.  
 

Financial Software can range from personal finance managers to entry level accountant 

programs and business financial management packages. Financial software can also consist 

of investment software packages and retirement planning. Financial software is a range of 

different programs that can be installed onto a computer to aid in the organization of 

accounts, numbers, employee information, etc.  
 

There are many popular accounting software packages available for small-and medium-sized 

organizations. Selecting right software for your organization involves many factors, including 

the design of your chart of account and the structure of your organization. It is important that 

you understand the capabilities of the software and how closely the software matches your 

organization‟s needs. The accounting software that you select must be flexible in selecting 

the reporting period. Most accounting software also provides added flexibility by allowing you to 

export the data into a spreadsheet format. You need to select the software package that most 

closely fits the needs of your organization. Here are some essential features to be considered 

when you are selecting your accounting software. 
 

1. Reporting and analysis: Any accounting program you evaluate must have robust 

reporting and analysis capabilities. Besides helping users gain insight into crucial 

financial activities, reporting and analysis functions help companies conform to 

government and industry regulations.  

2. Graphics: Graphics, in the form of charts and other illustrative formats, is a powerful 

tool that can be used to present trends and other concepts in a way that numbers alone 

can't convey. 

3. Automation: Support for simple accounting transactions and basic financial 

management tasks just isn't enough and many companies require the full automation 

of employee expenses, payrolls and time sheets; company and departmental budgets; 

purchase requisitions and other complex financial activities. 

4. Automatic updates: Using out-of-date accounting software is like eating food that 

has passed its expiration date. Tax laws, regulations and financial practices change 

over time, so it's vital to use software that receives fast, user-transparent, automatic 

updates. 

5. Customization: Chances are that no accounting software will exactly match your 

business's needs. That's why you'll want to look for a product that allows the easy 

customization of statements, forms, reports, screens, help systems and other program 

facets. 

6. Internet connectivity: With the whole world moving to the Internet,  make sure that 

any accounting software you consider has the ability to send and receive digital 

documents and handle electronic fund transfers. 

7. Interoperability: The data entered into your accounting software can be productively 

used by various business applications in HR, sales, shipping and other key business 

sectors. Conversely, you may want your accounting program to draw information in 

from other software products. That's why you'll want to check on an accounting 

program's ability to interoperate with other software before deciding on whether to 

purchase it.  

8. Scalability: Look for a product that accommodates, or can be easily upgraded to 

accommodate, a progressively larger number of users and a growing amount of 

financial data and transactions. Ask vendors about their programs' limits in these 

areas. 
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9. Expandability: Your business may grow in scope as well as size. The accounting 

program vendor should either offer add-on modules that allow customers to slap extra 

capabilities to its product, or a migration path to a full ERP environment. 

10. Security: If your company accounting data is lost or tampered, you lose time, money, 

business secrets (such as sales or profit data). Any vendor should be able to tell you 

about its software's built-in security features as well as how its product can mesh with 

your own on-site safeguards (such as anti-malware technology and network firewalls). 
 

5.2-Importance/Benefits of Accounting Software Packages 
Accounting software is a class of computer programs that enable you to manage your 

business's financial transactions. Such programs can vary widely in scope, with some 

programs designed for little more than simple bookkeeping and some designed to manage the 

entire financial comings and goings of large businesses. Using accounting software helps 

companies to use the resources in their accounting departments efficiently, and can reduce 

costly bookkeeping mistakes. 
 

Accuracy: Accounting software can help to increase the accuracy of your records by 

reducing or eliminating human errors in calculation. Manual bookkeeping processes involve 

making a lot of mathematical calculations by hand. An incorrect calculation early on in the in 

the process could have a great impact on the end balance. Computers, on the other hand, are 

virtually incapable of making such errors.  
 

Speed: Using accounting software allows businesses to process their accounts with greater 

speed than manual processing. Part of this speed increase comes from the use of computers, 

which are able to process figures far faster than the human brain. In addition, accounting 

software allows organizations to increase efficiency by introducing automation. Say, for 

example, that a business needs to record sales tax on all of its transactions. Accounting 

software could be configured to do that for each entry automatically, rather than having a 

staff member work out the tax longhand. 

 

Data Access: Using accounting software it becomes much easier for different individuals to 

access accounting data outside of the office, securely. This is particularly true if an online 

accounting solution is being used. 

 

Reliability: Because the calculations are so accurate, the financial statements prepared by 

computers are highly reliable. 

 

Automation: Since all the calculations are handled by the software, computerized accounting 

eliminates many of the complex and time-consuming processes associated with manual 

accounting.  

 

Cost: The benefits resulting from the speed and efficiency of accounting software often go 

hand-in-hand with reduced overall costs. The use of an accounting program allows each 

member of the accounting team to do more in a given time, potentially meaning that a smaller 

team is needed overall. This, in turn, can reduce the accounting department's payroll and 

administration costs.  

 

Reports: Accounting software helps businesses to supply the necessary members of staff 

with timely and accurate financial information. For example, suppose that a company's 

finance director needs a report of cash-flow to take to a meeting in two hours. Many 

accounting software systems have built-in reporting modules that enable users to create this 

type of report by simply filling in a form or clicking a button. However, creating such a 

report manually would be a time-consuming process. 
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Tax: Filing your business taxes can be a complex process, requiring you to keep close track 

of all your business's transactions. Accounting software helps to make this process easier by 

ensuring that all of your business's financial details are in one place. This allows you to 

calculate your return itself semi-automatically, rather than spending time and resources 

working out the necessary details by hand. 

 

 

5.3-The Advantages of Using Accounting Software  
An accounting system is a collection of processes, procedures and controls designed to 

collect, record, classify and summarize financial data for interpretation and management 

decision-making. 

Computerized Accounting involves making use of computers and accounting software to 

record, store and analyze financial data. A computerized accounting system brings with it 

many advantages that are unavailable to manual accounting systems. The accounting 

software carry out functions such as invoicing, dealing with payments, paying wages and 

providing regular accounting reports such as trading and profit and loss accounts and balance 

sheets 

 

The implementation of computerized accounting systems provide major advantages such as 

speed and accuracy of operation, and, perhaps most importantly, the ability to see the real-

time state of the company‟s financial position.  

 

A typical computerized accounting package will offer a number of different facilities.  These 

include: 

 On-screen input and printout of sales invoices  

 Automatic updating of customer accounts in the sales ledger  

 Recording of suppliers‟ invoices  

 Automatic updating of suppliers' accounts in the purchases ledger Recording of bank 

receipts  

 Making payments to suppliers and for expenses  

 Automatic updating of the general ledger  

 Automatic adjustment of stock records  

 Integration of a business database with the accounting program  

 Automatic calculation of payroll and associated entries 

 

Computerized accounting software can provide instant reports for management, for example: 

 Aged debtors‟ summary – a summary of customer accounts showing overdue amounts  

 Trial balance, trading and profit and loss account and balance sheet  

 Stock valuation  

 Sales analysis  

 Budget analysis and variance analysis  

 GST/VAT returns  

 Payroll analysis  

 

When using a computerized accounting system the on computer, input screens have been 

designed for ease of use.  The main advantage is that each transaction needs only to be 

inputed once, unlike a manual double entry system where two or three entries are required. 

The computerized ledger system is fully integrated.  This means that when a business 

transaction is inputed on the computer it is recorded in a number of different accounting 

records at the same time. 

 

5.4-Overview of Different Types of Accounting Software 
Accounting software can be useful in such functions as recording and processing accounts 

receivable and accounts payable transactions. Some software applications can be used in 
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payroll processing, the documentation of tax transactions, and the creation of related reports. 

Accounting software can also be used in billing clients and customers and debt collection. 

Some accounting programs even provide for timesheet record keeping, useful for 

professionals who need to keep track of the hours they work. 

Accounting software that is designed for home use is often referred to as personal accounting 

software. This type of software is used mostly in managing household budgets and expenses. 

Some personal accounting software makes it possible to download bank account information 

directly from the Internet for use with the software. 

There are many types of accounting software applications on the market today. Some 

applications are intended to perform accounting functions for large corporate organizations. 

Others are meant for personal use. Still other applications fall somewhere in between, 

performing functions suited to small businesses, as well as those suited to the average person. 

Available software ranges from the very simple to the very complex, with much variation in 

price as well. 

Low-end accounting software is generally used by smaller businesses and can typically be 

found for sale by a variety of retailers. Usually, software in this class is not highly specific 

and can be used for a wide range of businesses. This type of accounting program is usually 

adequate for such uses as generating invoices, reconciling accounts, and handling payroll. 

The next step up in the realm of accounting software consists of applications capable of 

performing a variety of functions important to business accounting. Referred to as mid-

market software, accounting applications in this class perform general business accounting 

functions and frequently include integrated management information systems. Many software 

applications at this level are capable of providing for accounting in several different 

currencies. Mid-market accounting software is usually purchased from a dealer. 

Higher-end accounting software is more expensive than other types and is usually much 

more complex. Generally designed for use by large businesses with millions of dollars in 

transactions, high-end accounting programs usually have very sophisticated features and 

options. Software in this class also allows for a high level of customization. Typically, 

higher-end software is sold through a dealer. 

Some companies choose to develop their own accounting software, gearing it completely 

towards their unique needs. Other companies choose to purchase ready-made software 

packages. Many organizations employ a combination of the two, purchasing software and 

applying local modifications to make it more efficient. 

Types of accounting software 

There are many different types of accounting software packages and applications currently 

available today. To select the best accounting product you will first need to decide your 

individual and corporate needs. Small business accounting software functions much 

differently in many respects that accounting software manufactured as an enterprise resources 

planning solution for example. 

 

If you are a large enterprise or firm you will want to investigate a comprehensive enterprise 

solution that offers multi-user capability. Some examples of popular software programs in 

this field include Oracle People Soft Enterprise One and mySAP All-in-One. If you are 

looking for a basic accounting software package you may opt for SAP Business One or 

Microsoft Great Plains software.  
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Small Business Software and Personal Accounting Software 

Small businesses can usually get away with a more basic program like QuickBooks 

Enterprise or Professional or MS Small Business Financials. If you are looking for an 

accounting software application for personal use, a basic accounting software program like 

quicken or QuickBooks or even Peachtree should easily accommodate your every need. Most 

of these software programs come equipped with accounts payables, account receivables, 

payroll and general ledger features. Most will also generate basic reports, invoices and keep 

track of other expenses, assets and small financial items you may want to keep track of from 

day to day. 

The primary difference between these smaller software applications and larger enterprise 

solutions is the smaller applications won't necessarily integrate to serve multiple operations 

like manufacturing, marketing and engineering. Most ordinary people or small businesses 

however will not need this capability in a software accounting package. 

A free 90 day trial version of MYOB accounting software can be downloaded from MYOB 

website. 

Review Questions 

1. Computerized Accounting represents a technological advancement in the field of business 

accounting. Do you use computerized accounting in your business? If yes, how important 

are the above advantages for the continued survival of your business? 

2. What are different types of accounting software available in market? Make comparative 

analysis of any three kind of accounting software that you know. 

 

 


